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NATIONAL ANTHEM

PLEDGE

Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga
Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,
Jaya he, jaya he, jaya he,
Jaya jaya jaya jaya he!

India is my country. All Indians are my brothers and sisters. 

I love my country, and I am proud of its rich and varied heritage.  
I shall always strive to be worthy of it.

I shall give my parents, teachers and all elders respect, and treat everyone 
with courtesy. 

To my country and my people, I pledge my devotion. In their well-being 
and prosperity alone lies my happiness.



Dear students,

	 The advancements in Information and communications technology 
have impacted every walk of life. The new age gives us the message that we 
need to stay updated throughout our lives. This book has been prepared to  
cover the latest domains in information communications technology, helping 
us stay in tune with these developments.

	 The chapters in this book, such as Graphic Designing, Desktop  
Publishing, Webpage Designing, Python Programming, Robotics, Animation, 
Database Management, and Cyber Space, are designed to help you think  
creatively, experience new concepts, and present novel ideas.

	 This book includes interesting activities involving Stellarium, the  
desktop planetarium software; PhET, the virtual lab; GeoGebra, the interactive 
geometry software; and similar tools. These tools would help you apply your 
learning to other subjects easily.

	 It is expected that the ICT tools you are familiar with will enable you to 
acquire knowledge through innovative methods. It will help you become a  
creative individual who can use technology in your own life and for the  
advancement of society.

				    With regards,

Dr. Jayaprakash R.K
Director
SCERT. 
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After visiting a design studio near the school and 
becoming quite familiar with graphic design, Sitara 
and her friends started preparing a description of it, as 
directed by their teacher.

Chapter 1
Design Factory 

Several people were trying to load a 
few massive boards wrapped in vibrant 
colours onto a vehicle. Some of the 
boards feature smiling faces, while others 
display tightly packed lines resembling 
dancing figures. A few are entirely filled 
with words. Scattered around, both big 
and small boards seem to be waiting for 
someone to pick them up.

As we stepped into the long veranda, 
lined on both sides with canvases covered 
in vivid drawings and writings, a man 
emerged. Wiping his hands on a piece 
of cotton waste and holding a brush 
that seemed ready to drip ink into one 
of the paint cups, he looked every bit the 

artist. He and his friends had beautifully 
written the name of the school on the top 
of our new school building.

He invited us into a large, beautifully 
decorated room. Inside, several people 
were working on computers with large 
screens, alongside printing machines 
unlike any we had seen before. In this 
room, letters, lines, shapes, and colours 
come together to create paintings that 
speak volumes.

Even the simplest line in their work 
can bring joy to anyone who sees it.

"This is where graphic designing 
happens," he said.
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Graphic Designing:
The World of Lines and Colours

Have you ever seen posters, banners, and boards 
used to promote ideas and products, and noticed their 
content and design? 		

Making posters and banners is a form of creative 
work. Many artists involved in designing posters and 
banners for various events in our region often use 
graphic editing software to assist in their work.

We have become familiar with various graphic 
design software in previous years. Free software such as 
GIMP, Krita, Inkscape, Scribus, and LibreOffice Draw, 
which are available on our school laptops, can be used 
for graphic editing tasks. Inkscape and LibreOffice 
Draw belong to the category of vector graphic editing 
software. The products created with these tools offer 
numerous advantages.

Inkscape is a free graphic designing software 
that both artists and web developers use to create high-
quality vector designs. How about using Inkscape to 
design a digital poster to commemorate Hiroshima 
Day?

You have already created notices, wall magazines, 
and posters. What are the steps to design a poster on a 
computer?

	� Creating canvas as per the requirement.

	� Adding text in the right way to effectively share the 
message of the poster.

	� Arrangement of drawings, images, and shapes to 
make the poster attractive.

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

Inkscape, a Design Factory
Inkscape is a Free vector graphic 
designing software. Inkscape 
is widely used to design logos, 
illustrations, posters, brochures, 
and typography with accuracy and 
creativity. This software has many 
tools that are easy to use for tasks 
like drawing, shape creation, and 
editing.

Inkscape's default file format is 
Scalable Vector Graphics (SVG). 
Inkscape supports file formats 
such as SVG, AI, EPS, PDF, PS, 
and PNG.
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Let's see how these elements can be put together 
in the poster to create a design that stands out and grabs 
the viewer's attention.

Open the Inkscape software on your computer to 
create a poster. Let's explore the window that opens up. 
(Fig 1.1)

On the left side of the screen, you can see the 
Inkscape tools and the colour palette below. Place the 
mouse on each tool to see its name.

Now, let's begin creating the poster.

First, we need to set up the canvas.

Fig 1.1  Inkscape Window

Let's prepare the canvas
You can't create a picture without a canvas. The 

canvas serves as the foundation for the ideas on a poster 
to grow and develop. Inkscape allows you to choose a 
page size that best suits your design. You can change 
the page size, units, and orientation at any time while 
creating your poster.
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Vector Images  
Raster Images 

The software GIMP and Krita, 
which you have learned about in 
previous classes, are Raster image 
editing tools. Since Raster images 
are made up of pixels, they may 
become pixelated or lose quality 
when scaled. JPEG and PNG are 
examples of Raster file formats.

Vector images are those that 
can be resized without losing 
quality. They are created using 
mathematical equations that define 
the lines and shapes. Their features 
include ease of editing, the ability 
to scale without loss of quality, and 
small file size. SVG and EPS are 
vector file formats.

Fig 1.2  Raster and Vector

Fig 1.3  Document Properties Window

To Adjust the Page Size 

	� Open in the order of  File → Document Properties 
(you can also use the shortcut key Shift + Ctrl + D).

	� In the window that opens, you can either choose an 
existing page size or type the width and height in 
the units you want to create the page.

	� Here, you can also select the page orientation.  
(Fig 1.3)

Let's Draw, Write, and Explore Tools
Inkscape offers a wide range of tools for both 

simple and complex graphic design tasks. Select tools 
from the toolbar on the left side of the canvas, draw 
various shapes in the workspace, and explore their 
uses. Then complete Table 1.1.

The workspace in Inkscape includes the empty 
area outside the page as well. This area can also be used 
to create design elements.

We have to create a poster with dimensions of  
300 mm x 350 mm. Open the Document Properties 
window in Inkscape and adjust the page size to match 
the dimensions of our poster.
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Tools in Inkscape

	� Select Create Rectangle & Squares (R) from the toolbar to draw a 
square.

	� Clicking on this square a second time will allow you to rotate it, 
converting it into a Parallelogram (Fig 1.4).

	� You can select objects using the Select and Transform Objects (S) 
tool to change their size.

	� Resizing the object by pressing the Ctrl key, will resize the object's 
length and width proportionally.

	� By clicking on the colour palette and selecting Fill Color, a colour can be applied to 
objects. Holding Shift while selecting a colour will add the color to the object's border 
(Stroke).

	� Formatting can be done by taking the Create & edit text objects (T) tool from the toolbar 
and typing the text (text format options appear in the Tool Controls bar at the top of the 
window when text is selected - Fig 1.5).

Fig 1.5 Text Format options

Tools Use
Create circles, ellipses, and arcs (E) To draw circle
Draw Bezier curves and straight lines (B)
Draw free hand lines (P)
Edit Path by nodes (N)

Create and edit Gradients (G)

Table 1.1 Some tools in Inkscape and their uses

Fig 1.4  On clicking the 
object a second time

A Background for the Poster
The background of a poster gives it life. The 

background plays a significant role in the overall appeal 
and effectiveness of the product. 
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To Remove Colour
To remove the colour assigned to objects, simply use 
the X at the left end of the colour palette. Holding 
Shift while performing this action will remove the 
stroke colour.

To make background for poster

	� Select the Create Rectangles & Squares (R) tool 
from the toolbar and draw a square on the page as 
shown in Fig. 1.6.

Fig 1.6  After Completing the Poster Background

The background colour of the poster can be 
chosen based on the type of content that will be added 
later. Let’s see how we can create a background for our 
poster.

You can use a single color (solid color), a blend 
of multiple colours (gradient colour), or an image, 
either individually or combined, for the background. 
Let’s follow these steps to give our poster a solid colour 
background.
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Be Clear and Loud
The message on a poster is an important part of 

communicating its idea clearly. The style, size, colour, 
and arrangement of the text should be designed in an 
attractive way. Designers often focus on delivering the 
message using as few words as possible but in the most 
powerful way.

We are creating a poster for Hiroshima Day. 
Before you start designing, it's important to decide 
what message you want to share with people and how 
the design should look. Use the text tool to add an  
anti-war message to your poster, similar to the one in 
Fig. 1.7.

Did you forget  
to save the file?

Adding Text to the Poster

	� Using the Create and edit text objects (T) tool, 
add the text to the poster. (Example: SAY NO TO 
WAR, AUG 06, HIROSHIMA DAY)

	� It is better to type words that require different 
formatting in separate text boxes.

	� Select the Font Type, Size, Colour and Position 
to make the text attractive. (Here, Font: Ubuntu 
Condensed, Size: 125 pt, Stroke Line Width: 2.5 
mm are given.)

	� To access the stroke settings, select Fill and 
Stroke from the Object menu.

	� To adjust the size of the rectangle precisely, select 
the rectangle using the Select Tool, and then type 
Width & Height (the same values   as previously 
entered for the page) in the Tools Controls bar.

	� To position this square exactly on the page, set the 
X, Y values to 0 (zero) in the formatting toolbar.

	� Select an appropriate colour from the palette 
below (the selected colour can be changed later if 
needed).
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Fig 1.7  Text Formatting

Message in the Poster
We know that the events in 
Hiroshima and Nagasaki were 
unprecedented acts of inhumanity 
in history. Shouldn't the message 
against war be the focus of this 
poster? 

Try arranging the typed message in the  
background as shown in Fig 1.7. Change the background 
colour according to the texts.

Image Design and Editing
	 Including a picture or design that represents 

the idea in a poster helps to communicate easily with 
viewers. Inkscape provides facilities to draw simple 
images, add photos, and edit them as needed.

The message of Hiroshima Day is against war. 
White colour, olive branches, and doves are often used 
as symbols of peace.

Including an image of a dove flying with olive 
leaves in the poster would make this idea clearer. Shall 
we try it?

A drawing of a dove (dove.svg) created in 
Inkscape is available in the School_Resources folder.

Open this file in Inkscape through File → Open, 
then copy the image and paste it onto the canvas.  
(Fig 1.8)
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Fig 1.8 Picture of Dove Drawn in Inkscape

Bezier Curve Tool

The outline of the dove is drawn using the Bezier 
Curve tool. The Bezier Curve Tool (B) in Inkscape is 
used to create regular lines and curved shapes.

Now we need the olive leaf. Let's draw it using 
the Bezier Curve tool.

The Draw Bezier curves and straight lines tool (Pen Tool) in 
Inkscape is an important tool. This name is derived from the name 
of Pierre Bézier (1910-1999), a French engineer.

It is used to draw straight lines and curves that can be adjusted using 
Nodes and Handles  

The Bezier Curve tool can be used to design complex shapes, logos, 
illustrations, and fonts.
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To Draw the Olive Leaves

	� Draw a small circle using  Create circles, ellipses, 
and arcs (E).

	� Duplicate it (Select the circle→Edit→Duplicate 
(Ctrl+D) and combine it in such a way that the 
halves meet together.

	� Give a different colour to the second circle created 
and reduce its Opacity. (To reduce the Opacity, just 
enter a number below 100 in the Opacity window 
found below the colour palette. (Example: 70) - 
see Fig 1.10).

	� Now the common part of the two circles is in the 
shape of a leaf. To retain only this part, select both 
circles together and click on Intersection in the 
Path menu.

	� Take duplicates of this as needed and place them 
at various spots on the stem that was drawn earlier.

First draw the Leaf Stalk as shown in Fig 1.9.

To Draw the Leaf Stalk

	� Select the Bezier Curve tool and click where you want to draw on the canvas (an anchor point is 
formed there).

	� Move the mouse and click at the point where you want to end the line, then press Enter. (The line 
can also be ended by Double-click or Right-click at the endpoint).

	� To curve the line on both sides, select the Edit path by nodes (N) tool and click on the parts of the 
line where you want to curve, then drag them (see Fig 1.9).

Fig 1.9 Olive Leaf Stalk Created with Bezier Curve tool

Now, using the tool  Create circles, ellipses and arcs 
(E), olive leaves can be drawn
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Fig 1.11 Fille and Stroke window

Make sure to adjust the size and orientation of 
the leaf accordingly. Don’t forget to give colours that 
match the olive's stem and leaves. (Fig 1.12)

Once the activity is completed, select both the leaf 
and the stalk. Then, group them by pressing Ctrl+G. 
After attaching the brick to the dove’s beak, the image 
of the dove flying with the olive leaf is completed.

Enhancing Shapes
Using Fill and Stroke, colours can be applied to both the interior and the border of shapes. 
The Stroke style window allows choosing different types of borders and adjusting their 
thickness.

To blend edges and bring shadows and a three-dimensional effect to designs, the blur option 
in the same window can be used. The Opacity adjustment is used to control the transparency 
of colours, making shapes partially or fully visible.

Fig 1.10 First phase of drawing the leaves
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Making the Picture Attractive  
We can include the dove flying towards the sky 

with an olive leaf of peace in our poster. What can be 
done to make this image more attractive?

Draw a circle and add it to the background of the 
image.

Drawing a Circle as the Background for the Picture 

	� Take the Create circles, ellipses and arcs (E) tool and draw a small circle. You can give 
the circle  red colour.

	� Bring the flying dove with the leaf into this circle.

	� Right now,the circle is on top, and the dove is underneath. Use the Pg Up and Pg Dn keys 
to bring the dove to the top.

	� To change the colour of the lines (Stroke colour) used to draw the dove (e.g.white), select 
the image and hold down the Shift key while clicking on the desired colour.(Fig 1.13)

How about improving the circle we created by 
adding a few smaller circles within it to form a pattern 
and make the design more attractive?

First, remove the dove from the circle, and then 
make changes to the background circle.

Fig 1.12 Olive Leaves Drawn in Inkscape
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Fig 1.13 When background is added to the picture

Pattern can be Created by Joining Multiple Circles

	� Duplicate a circle, reduce its size slightly, and arrange it inside the original circle. (Make 
sure the ratio of the circle does not change when altering the size).

	� The new circle can be given a slightly darker colour than the existing one.

	� Draw a few more circles in this manner, gradually decreasing in size, and arrange them so 
that they come to the centre of the circle, giving them more and more dark colours.

	� Use Align and Distribute in the Object menu to align and arrange multiple shapes as 
desired (Figure 1.14).

Fig 1.14 Align & Distribute Window

Try the activities given below.

Align and Distribute

Align & Distribute is a powerful 
tool for arranging design elements 
with accuracy. It allows you 
to position multiple objects as 
intended, either next to each other 
or relative to the page.
You can open this window by 
pressing the Shift + Ctrl + A keys 
together.
The items can be arranged either 
by their page order or based on 
the first or last item selected.
The Align & Distribute feature 
is especially helpful for designs 
that require high accuracy.

Find out the method in Align and Distribute 
which was used to arrange the circles concentrically.
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Fig 1.15 Flipped Image

Once the text, images, and other design elements 
needed for a poster are ready, the final step is to arrange 
them in an attractive and effective layout.

Arrange the image and text in appropriate 
positions above the square background of the poster. 
Ensure a balanced relationship between all the design 
elements.

When you revisit the poster and imagine yourself 
as a viewer with different preferences, you'll likely 
spot areas that can be improved. Use your creativity to 

Digital posters are visual 
communication tools created 
using graphic designing software. 
They convey messages through 
design elements such as text, 
graphics, and imagery.

They are especially useful for 
sharing ideas on social media 
platforms. Digital posters 
differ from traditional posters 
due to their variety, ability 
to be continuously updated, 
and potential for widespread 
distribution.

The circle pattern is ready as the new background. 
Now, reattach the image of the flying dove holding 
the olive leaf at the top of the circle. Do you notice 
anything strange?

The dove and the olive leaf have gone below the 
circle, haven't they?

	� Which key can be used to bring the dove to the top?

	� What must be done to make this dove turn right as in 
Fig 1.15? Check the Tool Controls bar at the top of 
the canvas to see if this option is available.

	� Can we position the dove's beak slightly outside the 
circle?
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Fig 1.16 The Completed Poster - Against War

add and refine details, making the poster more visually 
appealing (Fig 1.16).

Export the Poster from the Canvas  
The anti-war poster for the Hiroshima Day 

campaign is now complete. Save the file once more.

Shouldn't the poster be exported from the canvas? 
We can convert the image to PNG format for convenient 
sharing through social media.

Export the poster you created to PNG format 
using the Export PNG Image option.

Exporting in Inkscape
Inkscape files can be exported to 
a variety of formats, including 
PNG, JPG and WEBP. Be sure to 
select the appropriate resolution, 
file size, and format for web and 
print projects. For screen/web 
display, a resolution of 96dpi is 
sufficient, while for print, 300dpi 
is preferred.

Export to PNG from Inkscape

	� Select and group all the objects in the poster together.

	� Select File → Export PNG Image. (Fig 1.17)

	� In the window that opens on the right side, select Selection from the Export area. (You can 
export either the entire page or only the selected portions.)
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By the time the poster was finished, everyone 
had become skilled at designing. Now, prepare another 
poster on your own using Inkscape.

Fig 1.17 Inkscape - Export window

	� Make necessary changes in Resolution.

	� Name the file and choose the folder to save it in.

	� Then export the file.

Shadows and Light in Harmony
It is easy to draw three-dimensional shapes using Inkscape. This is done by using 

shading that creates a sense of the glow and shadow that is created when light falls on an 
object. Inkscape's Gradient tool and Blur effect can be used for this purpose.  Let's see how 
to draw a ball using these.

	� Select the Create circle and ellipses, arcs (E) tool in Inkscape and draw a circle (you may 
need to hold down the Ctrl key to make it a full circle).

	� A dark colour (e.g., dark blue) can be applied to the circle.

	� Make a copy of the circle and place it on top (Ctrl+D).

	� After selecting the Create and Edit Gradients (G) tool, choose Radial Gradient from 
the Tool Controls bar. Then, click on the upper circle and drag (the Gradient Handles 
will appear on the circle).

	� For shapes in a straight line, Linear Gradient should be used.
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Let's Assess

 	Which tool should be used in Inkscape to create custom shapes by editing nodes and curves?

	 a)	 Rectangle Tool				    b)  Circle Tool
	 c)	 Pencil Tool	 			   d)  Bezier Tool

	 	What happens when two shapes are combined and selected in Inkscape, and the 'Path → 
Difference' operation is applied?

a) The two shapes combine to form one.

b) The part where the two shapes join is removed from the figure below..

c) Copies of both shapes are created.

d) The two shapes are divided into two parts.

	 What happens if you set the Transparency of an object to 0% in Inkscape?

a) The object becomes transparent and cannot be seen.

b) The object turns white.

c) The object turns black.

d) The object is removed from the canvas.

	� Then, using the Edit paths by Nodes (N) tool, click on the middle of the Gradient Handles 
to give it a lighter colour (e.g. light blue) and click on the edges to give it a darker colour.

	� Adjust the brightness of the light and the depth of the darkness on the opposite side by 
dragging, stretching, and repositioning the Gradient Handles as needed.

To add the ball's shadow, draw an ellipse beneath it and adjust its position and size. Set the 
colour to black, and in the Fill and Stroke window, adjust the Blur and Opacity settings as 
needed. Use the Pg Dn key to position the shadow below the ball.
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

Extended Activities

1.	 Use Inkscape to create more smilies similar to these.

2.	 Draw the shape given below in Inkscape. Use 'Linear gradient' to design the outside of the 
cylinder.

3.	 A 6'x3' banner is needed to be placed behind the stage at the releasing ceremony of a short 
film made by teachers and students of the school. Design this banner in Inkscape and export 
it as a PNG file.

4.	 Prepare a cover page for the magazine that is intended to be published by the Vidyarangam 
Kala Sahithyavedi.

5.	 Imagine your school is hosting the Little Kites District-level camp this year. Use Inkscape 
to design a badge for the children participating in the camp.
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How many attractive and well-designed 
publications do we get to read every day! Check out the 
newspapers, periodicals and books that are available in 
the 'reading corner' of your school and library. Have 
you noticed the features of the arrangement of content 
in these? 

News magazines and books which are published 
with excellent designs communicate with readers 
clearly. What makes each publication better is its 
visual beauty along with the quality of its content. 
With the advent of technology, we have developed new 
techniques and possibilities to make and improve the 
design of pages attractive.

Effective communication is the core of a page 
design. Newspapers and publishers have developed 
their own design style to make the content attractive.

Have you too come across the situations of page 
design ? We may require tools and techniques related to 
page design while preparing school newspaper to share 
the school news and reports  and also while preparing 
digital magazines.

Chapter 2
Let's Prepare a Newspaper 

"Well designed pages 
are like an artwork.
They keep on talking 

to us."
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Fig 2.1  School Newspaper- Model

A newspaper for School
Look at Fig 2.1. The image shows the sample of 

the front page of a school newspaper published by a 
school in Idukki district. What are the features of its 
design?

	� Large heading.

	� Excellent arrangement of news.

	� Content divided into columns. 

	� ...................................................................................

When designing newspapers or magazines, 
factors such as the images, fonts, headings, colours, 
captions, arrangement of letters and use of blank 
spaces play a crucial role in making the pages visually 
appealing. In earlier classes, we learned how to 
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create documents using LibreOffice Writer. However, 
specialized Desktop Publishing (DTP) software is 
used to design pages for publication and to prepare 
multi-page documents. The process of designing and 
publishing newspapers, magazines, books, etc., using 
such software is known as Desktop Publishing. 

Now, let’s try creating a school newspaper, 
as shown in Figure 2.1, using a DTP software called 
Scribus, which is available on our computers.

Desktop Publishing (DTP)

Desktop Publishing (DTP) is a method of preparing and printing pages using various 
designing software on a computer. In the past, the process of publishing a book involved 
multiple stages, with different professionals (such as typists, graphic designers, copywriters, 
typesetters, and printers) working on separate tasks. With the advent of DTP, these steps 
can now be completed quickly by one person or a team of experts, all working at the same 
location using graphics-based computers.

Scribus is a popular open-source desktop 
publishing software used for designing magazines, 
books, and newspaper pages. Many well-known 
Malayalam newspapers today use Scribus to design 
their pages. Other notable DTP software includes 
LaTeX, Adobe InDesign, Microsoft Publisher and  
QuarkXPress.                                                     

To the Page Design …
Look at Fig 2.1. The model of the first page of the 

newspaper we are going to create is shown here. What 
are the key features of this page?

The design of the front page is crucial in a 
newspaper layout because it acts as the "window" to 
the newspaper and showcases the most important news. 
The design style of the front page must be eye-catching 
and impactful. This page presents only brief snippets of 
information and images, without detailing the full news 
stories. Hints about the content in the inner pages are 
also provided here.
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To Start a New Document in Scribus

	� Open Scribus and select suitable Page Layout (here 
single page) from the New Document window.

	� Select various settings like page size, number of 
pages, orientation, margin etc. from here.

	� Then enter OK.

The design of such a page can be completed 
through various steps. 

This is done by predetermining the page settings 
of the document we intend to print, in DTP software 
like Scribus.

Here we are going to prepare a document 
containing two pages.  Open Scribus and start a new 
document for our newspaper after setting the necessary 
page configurations.	

Prepare Content
Collect news, images, cartoons 
etc., for preparing your school 
newspaper and save them to the 
computer.

Fig 2.2  Scribus New Document Window

Have you opened a new document in Scribus ?

Look at the Scribus window that is now open. 
Check the tools and facilities for page design in this 
window.  Take a look at Fig 2.3 for assistance.
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Menubar

Ruler

Titlebar
Toolbar

Canvas

Status bar

Properties window

Selection

Text frame

Image frame

Shape

Polygon

Line

Bezier Curve

Fig 2.3  Scribus window Fig 2.4  Tools in Scribus 

Let's prepare a banner 
Have you familiarised with the tools and facilities 

in Scribus. 

Look at the Fig 2.5.   As part of page designing 
we shall prepare a banner shape as in the model first.

Fig 2.5  Banner Model

We can use different types of shapes in page 
designing to communicate the idea clearly. Shapes help 
us determine the importance of the content and arrange 
the content on the page in a way that grabs the reader's 
attention. 

	 Create a banner for the front page of your 
school newspaper in Scribus using shapes like the one 
in Figure 2.5. The Shape tool can be used for this.
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Properties Window
Additional techniques related to the arrangement of 
objects included in a page in Scribus are available 
in its Properties window. You will see separate 
properties windows for objects and texts. These 
windows can be seen from the Windows menu or 
from the menu obtained when right-clicked on the 
object.

To Prepare Shapes in Scribus

	� Select the Shape tool from the toolbar and draw a 
square on the canvas (Fig 2.6).

	� The dimensions are displayed at xyz at the top 
of the Properties part of the drawing. Enter the 
required dimensions here.

 (Height : 28 mm, X-Pos :14,

 (Y-Pos : 83, Width :145)

Fig 2.6  Shape Drawn Using Shape tool



31

Let’s Prepare a Newspaper

Information & Communications Technology-10

Colour the Square 
We have already understood that the choice and 

combination of colours play a crucial role in graphic 
design. Colours are equally important in page design 
when using graphics, as they can effectively draw the 
viewer's attention.

Examine the newspapers and periodicals available 
in your school to observe the types of colours used in 
them. 

Now, let’s proceed to colour the square we have 
drawn (Fig 2.7).

Fig 2.7  Coloured Shape

	� After selecting the rectangle, open the tab Colours 
from the Properties window.

	� Select the required colour in the Fill mode from 
Fill.

	� Select None in the Stroke tab as there is no need of 
stroke colour here.

To Give Colour to Object in Scribus
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Colour Palette in Scribus

In Scribus, there are three different methods to colour a shape namely Solid, Gradient, 
Hatch.  Only limited number of colours will be displayed by default in the Colour Palette 
of the Properties window.   Click on the Colours and Fills from Edit menu in order to get 
more colours.  We can see the options for adding and removing colour here.  In the Merge 
Colour Set seen here select Oxygen instead of Scribus Basic and click OK.  What change 
has occurred in the Colour Palette?                                               

Adjust the Shape of the Figure
Observe the shape of the rectangle of the model 

of the banner (Fig 2.5).  How can we change the shape 
of the rectangle we have drawn?  Let’s do this activity.

We can change the shape of the figure drawn in 
Scribus in various ways.  Node Editing is a technique 
for that.

Fig 2.8  When the Shape of the Figure is Changed
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Node Editing in Scribus

We know how to change the shape of figures using Edit paths by nodes in Inkscape 
software.  Such an option to change the shape of figures using Node Editing is available in 
Scribus also.

In Scribus, the Node Editing window will be displayed when double clicked on 
an object for editing its Path.  We can change the nodes, add new nodes or delete a node  
as needed.                                       

Nodes

X-Pos/Y-Pos

Move Nodes

Add Nodes

Delete Nodes

If we make a small change in the size of the  
prepared shape using the Node Editing technique, we 
will get the new shape as shown in Fige 2.8. The width 
of the current shape is 145 mm. Change the width of its 
bottom side to 120mm instead of 145mm. 

With this, we can see that the position of the 
selected node has been shifted slightly to left and the 
width of the rectangle in this side has been slightly 
reduced.  Now we get the desired shape (Fig 2.9).

	� Double click on the drawn Shape 
and open the Node Editing 
window.

	� Change the value in the X-Pos 
box in the Node window after 
clicking on the right bottom 
corner of the Shape.

To Change the Dimension  
of the Shape
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Fig 2.9  Node Editing Window

Now, take a copy of this shape in order to 
prepare the black coloured shape seen on the right side.  
Remember that you have to flip it to get the new shape.

	� Select the first shape and copy it by clicking Item 
→ Duplicate/Transform→ Duplicate.

	� Give black colour to the copied shape.

	� After that, click Flip horizontally under X,Y,Z → 
Level in Properties (Fig 2.10)

	� Then, adjust the image as shown in Fig 2.11 using 
Flip vertically in the same window.

	�  Arrow keys on the keyboard can be used to adjust 
the two shapes accurately.

To Prepare the Black Coloured Shape

Fig 2.11  Shape Obtained When Flipped

Fig 2.10  Level Window
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Apply Shadow to Object
 The background of the banner has been created.  

If we give shadow to the shape prepared now, it will 
make the banner more attractive.  

We can give shadow to the objects using Drop 
Shadow option in Scribus.  

Give Shadow to the object you have prepared 
now.  (Fig 2.12).

	� After selecting the object to 
which shadow has to be given, 
click on the Drop Shadow tab 
in the Properties window.

	� Put a tick () mark in the check 
box of Has Drop Shadow in the 
window that appears now.

To Arrange the Shadow

Fig 2.12  Image Giving Shadow

Have you finished giving shadow? Click on the 
Preview Mode icon in the toolbar to see what our 
design looks like. (Fig 2.13) 

Don't forget to save the work done so far  
(File → Save). 

Let’s Give Title 
The title of the newspaper is very important. A 

good header makes a document more distinctive and 
attractive. 

Text frames are required to include and format 
sentences in Scribus.  The text could be added only in 
text frames.   The Text frame (T) tool is the option for 
adding text to a page in Scribus. 

Let’s prepare an attractive title for our newspaper 
using Text frame.

Fig 2.13  Preview Mode icon
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	� Select Text frame tool from the Toolbar.  (This option is also available in Insert menu).

	� Add frame by dragging in the canvas.

To Include Text in Scribus

Let’s Make the Title Attractive
It is possible to give a required colour to the title 

using Colour & Effects from the Text Properties 
window.  Try giving different colours to the title of your 
newspaper and make it attractive.

What are the different options available in the 
Text Properties window for making the characters 
more attractive ?   Complete the list given below.

	� Colour & Effects

	� ……......................

	� …………………..

	� …………………..

While Adjusting the Font Size of the Characters

If the font size of the characters included in the page is larger than the size of the Text frames, 
then adjust the size by dragging the nodes available at the corners of the text frame.                                 

	� Select required Font 
from the Text Properties 
window (Fig 2.14)

(In order to get Malayalam 
select Unicode Malayalam 
fonts)

	� Click inside the Text 
frame and type the 
heading.

	� Adjust the font size.

Font name

Font size

Line space value

Linespacing mode

Font colour
Font shadow colour
Font background colour
Font shadow on/off

Fig 2.14  Text Properties Window
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Can you see a shadow of the title given in the 
figure 2.15 ?  Give shadow to the title you have included 
as well.

Include Subtitles
Refer to Fig 2.16. The name of the school is added 

below the title as a subtitle, and the publication date of 
the newspaper is placed on the left side. Include similar 
elements in your page as required.

On the sample page (Figure 2.16), the email 
address is placed between two lines below the name 
of the school. Lines can be added in this way using the 
Line Tool in Scribus

Fig 2.15  Title of the newspaper

Fig 2.16  Subtitle Added to the Page

Adjust the Line space
Automatic Line spacing can be 
used  to adjust the spaces between 
the lines of the text.

To adjust the space between the 
words, select the whole content and 
apply Justify from the Alignment 
settings in Text Properties 
window.
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	� Select Line tool from the Toolbar.

	� Press the Ctrl Key in the keyboard, click on the starting point of the line and drag in 
straight.

	� More lines can be added by taking copies of this line.

To Include Lines

Complete the design shown in Figure 2.16 by 
adding lines using the Line tool and including the 
necessary text.

Include Images
A publication's first interaction with its readers is 

through the front page.  Therefore, the selection of the 
content on the front page is very important. 

We have recognized the importance of images 
in effectively communicating ideas. A powerful front-
page image can capture the reader’s attention and 
convey the message quickly.

How are images added to a page in Scribus?

You may have stored images on your computer that 
need to be included in your newspaper. Additionally, you 
can use the images available in the School_Resources  
folder.

Image Frames in Scribus

Image Frame is a technique 
for including images in Scribus. 
When you add an image frame to 
the page, it will be displayed as a 
rectangle.

The said frame can be changed 
accordingly to another shape if 
needed. 

Image frames can also be created 
by drawing a shape using the Shape 
Tool and then select Convert to 
Image frame which is obtained on 
right clicking the shape.

Fig 2.17  Image Included in a Page

	� Select the Image frame from the toolbar.

	� Then click and drag to the part where you want to 
insert the image and insert the frame.

	� Right click on the frame and from the window that 
appears  click on Content → Get Image.

	� Open the folder containing the image and select the 
image and click OK.

	� To adjust the image within the frame, right click on 
the image and select Image → Adjust Image to 
Frame (Fig 2.17)

To Include Image in a Page
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To Refine the Resolution  
of the Image

Right click on the image and give 
a tick mark to the Full Resolution 
from the Preview Settings.  

Have you included the image ? Now, enlarge the 
frame using the Selection tool and adjust the image to 
the required size on the page. 

You can also see the QR Code image of   
Schoolwiki school page on the right side of our 
newspaper headline. Similarly, include the QR Code 
image of your schoolwiki page on the top of the 
newspaper .

	� Click on the Barcode icon on the 
Scribus Toolbar.

	� Make the following changes in the 
Insert Barcode window that opens up 
(Fig 2.18)

	� Select Two dimensional symbols 
against Barcode Family.

	� Select QR Code against Barcode.

	� Enter the schoolwiki page address of 
your school in Contents.  

	� Then click OK.

	� You will get an image frame on the 
mouse now.  Click and adjust where 
the QR Code is to be included.

To Create QR Code

Fig 2.18  Scribus QR Code Window

So you have added the QR Code of SchoolWiki 
Page.  What else should be added to the page? 

	� ………..........................….

	� …........................………...

We have not added news on the front page. 
For this, the news containing the special functions or 
activities of your school should be prepared and typed 
as a text file and make sure that it is saved on your 
computer. 
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Align the Letters
In newspapers, news is arranged in different 

columns. Vertically divided columns are an easy way 
to fit more letters in less space. The size of the columns 
vary in length depending on the importance of the news.

Content can be arranged appealingly using the 
Text frames and  connected techniques in Scribus.  

Arrange the collected news in different columns 
on the front page using the Text frame tool in Scribus.

	� Select Text frame from the Toolbar.

	� Adjust the Text frame by clicking and dragging below the image arranged on the page so 
that it fills up to the page margin.

	� Click on the Columns & Text Distance tab in the Text Properties window and enter the 
number of columns and the gap.

	� To bring the text into the frame enclosed in columns,

	� Right-click inside the text frame.

	� Then select the prepared text file from  folder using Content → Get Text  option and 
click OK.

To Arrange Text in Columns

Did you experience any difficulty in reading the 
Malayalam contents included in the text frame? 

If the text other than English entered into Scribus 
are unreadable, we can solve it by adjusting the 
language and font of the content.

	� Select the whole text included in the frame  
(Ctrl + A).

	� Select Malayalam from the Language box and 
select appropriate Malayalam Unicode font from 
the Font box available in the Text Properties 
window at the right side.

To set Malayalam Font in Scribus

Text Overflow Icon

If the content placed in a Text frame 
exceeds the frame's capacity, an 
overflow icon appears at the right 
bottom of the frame to indicate 
that there is text remaining.  By 
clicking on the icon, you can insert 
the rest of the content on the next 
page or anywhere else you want.
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Look at the Malayalam content in your textbooks. 
The most important typeface used in its preparation 
is THUMBA, a Unicode font developed by CDIT, a 
government organization. What are the other Unicode 
Malayalam fonts? 

	 Check your computer and complete the list 
given below.

	�  Manjari 

	�  RIT Ezhuthu 

	�  ..................... 

	�  ..................... 

	�  ..................... 

Change the content added to the page to different 
fonts and observe the differences. 

You may save the work you have done so far. 

Images in between Text 
When adding images to a Scribus page that 

contains text, sometimes the entire text may not appear 
alongside the image. In order to avoid the problem when 
text and images are mixed in this way, make necessary 
adjustments in Contour Line of the image.

Desktop Publishing - 
Career Opportunities

You can easily find a job in the field 
of designing if you have artistic 
talent and a good proficiency in 
using DTP software. 

A large number of DTP professionals 
are currently employed in fields 
such as graphic designer, layout 
artist, desktop publisher, and print 
production specialists.  Desktop 
publishing has employment 
opportunities in industries, 
entertainment and education 
(newspaper and magazine design, 
film, advertising, etc.)

	� Select the image.

	� Select the Shape → Text flow around frame 
option in the Properties window.

	� Click Edit next to Shape. A contour line will 
appear around the image.

	� Adjust the distance of the contour line's nodes to 
the outside of the image frame. (Fig 2.19)

To arrange images with texts

If the Image is below the Text
If the image is below the text frame, you can use 
Level → Raise to Top by clicking on the image.
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Fig 2.19  Contour Line Editing

The Text Flow facility is available in the Shape 
window to arrange letters in various ways. Use each of 
these and list their uses. (Table 2.1)

Text flow around frame disabled To view the letters over the image

Text flow around bounding box

Text flow around contour line

Text flow around frame shape

Table 2.1  Text Flow Options

Titles and Subtitles can be Added 
Just like images, headlines play an important 

role in news. Main headlines are typically larger and 
bolder, while subheadings support the main headline by 
providing additional details.

Add the necessary headlines and subheadings to 
your news using new text frames.
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Fig 2.20  Front page completed

Set Background Colour 
Special editions of newspapers and magazines 

are now published in multicolour. If you draw shapes 
using Shape option in Scribus, you can colour the page 
according to the shapes. It can also colour entire pages 
if shapes are used as backgrounds. 

Give background colour to the front page of the 
newspaper.

	� Draw a rectangle which fills the whole of the page 
using Shape tool from the Toolbar.

	� Colour the rectangle.

	� Right click on the rectangle and select Level → 
Lower to bottom, for arranging it behind the text.

To Set Background of the Page

Our first page is ready. (Figure 2.20) 

Now, prepare the second page in the same way. 

Don't forget to save the file when changes are 
made in the document.

Export the Document 
We need to print the prepared document.  For this 

we have to convert this to either PDF format or other 
formats that support printing. 

Export your newspaper to PDF using the File → 
Export feature in Scribus. 

Don't forget to print the newspaper and distribute 
it in school.

 	What is Scribus mainly used for?

	 a)	 Video editing				    b)  Photo editing
	 c)	 Desktop publishing			   d)  3D modelling

Let's Assess
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	 	What is the use of Text frames in Scribus?

a) to draw shapes.

b) to type sentences and format them.

c) to include images.

d) to colour the background.

Extended Activities

1.	 Prepare your school magazine using Scribus.

2.	 Create posters for the school’s Day celebrations using Scribus software and share them.


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Chapter 3
Computer Language 

Look at Fig 3.1. Can you identify the difference 
in Sandeep's routine during the holidays?

What did you find? 

Certain things that are done on normal days are 
not done on holidays, right?

Sandeep's daily schedule is based on the habits, 
suggestions and knowledge he gained from various 
sources.

Fig 3.1  Schedule of routine

Today is  
a holiday, 

Mom.

It is past 6 O' clock. 
Why don't you  

get up?
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Aren't we the same?

The knowledge and habits gained from 
experiences and studies, along with the advice or 
instructions  we receive from others,  lead us.

Don’t you know that computers also work based 
on the instructions given to them and the knowledge 
they gain from those instructions?

How do computers understand the instructions 
we give them? 

A computer is an electronic device. Like any 
electronic device, computers only know ON and OFF 
states.

Instructions are given to computers through 
binary language codes that only use the symbols 0 and 
1 to represent ON and OFF states.

But we don't know binary language. Then how can 
we  give instructions to computer in binary language?

Imagine you have a friend who only speaks 
Bengali, and you don’t know the language. How would 
you communicate with them?

A mutual friend who understands both Bengali  
and Malayalam could help you communicate effectively.

In this way, our computers have programs that can 
translate instructions given in a language into binary 
language. These are known as high-level languages and 
translator programs.

Translator programs are mainly of two types - 
Compilers and Interpreters.

Computers with the help of translator programs 
understand and act according to the high-level language 
instructions that we give.

Binary Language

A language that uses only ON and 
OFF is called a binary language.

These states are denoted as High, 
Low  or 1, 0 or True and False.

I will tell you  
what he intended.
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Compilers and Interpreters

Compilers are translators that completely convert instructions into binary language and 
compile them into a separate file. In contrast, interpreters process and execute each line of 
code one at a time during execution.

Binary files (executable files) created by compilers do not require the original high-level 
language code (source code) to run later. However, when using interpreters, the source code 
must be present on the computer to execute the program.

High-level programming languages such as C, C++, and Java use compilers to convert and 
run programs. Python, on the other hand, is an interpreted programming language.

Let’s get familiar with such a high-level language 
in this lesson.

Have you noticed the daily routine of Sandeep 
given at the beginning of the lesson? Sandeep is working 
on the instructions received one by one for each day.

Similarly, computers can be given precise 
instructions to solve a problem and thus can be used for 
problem determining and solving. In this way, it is said 
that programming is giving the necessary instructions 
to computers to do a specific work.(Task). 

For example, suppose the computer needs to be 
given instructions to prepare a program to calculate the 
age of a person.

What are the information needed to determine 
someone's age?

	� You should know in which year the person is born.

	� ...................................................................................

What is the age of a person whose year of birth 
is 2011?

If the current year is 2025, the person will be  
14 years old, right? How did you find it?

Just subtract the  year of birth from the current 
year.
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That is,

Age = current year - year of birth

If the above mentioned things are written step by 
step,

•	 Current year  (current_year)=2025      

•	 Birth year (birth_year)=2011                                          

•	 Age = Current year -  Birth year 
(age=current_year – birth_year) 

•	 Display the age on the computer.

The process of writing the steps for solving a 
problem in a specific order is called an algorithm.

Let's prepare a computer program  to calculate 
the age of a person according to the above given steps.

Which computer language should we choose to 
prepare this program?

Many languages are available today for 
developing computer programs.

Which are the computer languages you have 
heard of?

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

Java, C, C++, Python, Ruby, PHP and many other 
programming languages are currently available for 
programming. Here we use  the language Python for 
making programs.

 To give instructions  
to the computer  

we need to know   
programming language.
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PYTHON

Python is a suitable programming language for everyone—from young beginners exploring 
programming to experts working on advanced concepts like robotics and data science. Its 
simple syntax makes it easy to learn and use.

Fig 3.2  Guido van Rossum Fig 3.3  Python Logo

The Python language was developed in 1990 by Guido van Rossum (Fig 3.2), a 
computer engineer from the Netherlands. Python is an open-source programming language.

Lets Make a Python Program 
Let's see how to make the program for calculating 

age that we mentioned earlier using Python.

For this we have to use the Text Editor application 
on our computer. A Python interpreter is required to 
translate the prepared program into binary language.

Look at the program given below. The previously 
written algorithmic tasks are  converted  to Python 
language here. Open the application called Text Editor 
on the computer and  type the program, without making 
mistakes. Then save it in your folder.

birth_year=2011

current_year=2025

age = current_year - birth_year

print("Your age is : ", age)
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Fig 3.4  Terminal Window

Program files written in Python should have the 
extension .py added to their file names. For example, 
the age finder program can be saved as Find_age.py.

Isn’t the file saved? Now try to run the file   
Find_age.py using the Python3.

	� Open the folder where the file is saved.

	� Right click on the empty space in the folder. Click 
on Open in Terminal.

	� Then, type the below given command in the 
terminal and press Enter.

	 	 python3 Find_age.py

To Run Python File

See that when the program is run, the age is 
printed on the terminal. (Fig 3.4)

Check and find out how the line print(“Your age 
is :” , age) is run in this program.

After printing the text ‘Your age is :’ the calculated 
value is printed in place of age.

A similar program to find the area of a square of 
fixed length and width is given below.

length=35

breadth=65

......................................................

print(“Area of Rectangle is: ”, area)

In Scratch,  
instructions are given 

for sprites  as well.
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Variables

Just like in mathematics, variables 
can also be used in computer 
programs. They are used to 
temporarily store data required for 
the program to run.

When using variables in a program, 
their names should start with a 
letter (alphabet) and must not 
include special characters, except 
underscore ( _ ). 

The term Datatype indicates what 
type of data each variable contains. 
Examples of datatypes include 
integers, floats, strings, images, 
audios, dates, and times. However, 
in Python, you don’t need to 
specify the datatype when creating 
variables.

What should be added to the missing line in this 
program? 

Open a new document in a Text  Editor, complete 
the program, save and run it.   

When the program was run to calculate age, 
we got the output based on the year we entered in the 
program. Anyone running this program at any time will 
get the output "14 years."

What should be done to convert this to a program 
that displays the age of any person who runs the 
program ?       

If it is possible to input the current year and birth 
year to the program while running the program,  it can 
be used anytime to calculate anyone's age, right?   

Let's see how this program can be modified by 
giving name, birth year and current year of any person 
as input while running the program.  

Instead of the statement birth_year=2011 in the 
above program, try the following statement. 

birth_year=input(“Enter your year of birth:”)

After changing the program, run it using Terminal.

What did you find?

................................................

................................................

In this way, let's add the following lines at the 
beginning of the program.

name=input( “ What is your name?:”)

current_year=input(“Enter current year:”)

When we run this program it asks for your birth 
year, name and current year and stores the birth year, 
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While Using the Input Function 

In Python, data obtained using the input function is in text format, also known as a string.

Information like a person's name or address is typically made up of alphabetical characters, 
while details such as year of birth, height, or weight are represented as numbers.

Mathematical operations like addition, subtraction, multiplication, and division cannot be 
performed on text. Therefore, numbers in text format must be converted to numeric format 
for calculations.

name and current year typed by keyboard in the variables 
birth_ year, name and current_year respectively. 

Save and run this program.

Did you get the output when made changes in this 
program?

This problem arises because mathematical 
operations are not possible with the inputs we have 
given. Difference can be calculated only if the data 
obtained as input is converted into numbers.

The function int() can be used to convert data 
available in String form to integer form.

Let’s rewrite the program as given below 
accordingly.

name = input("What is your name:")

current_year = input("Enter current year:")

birth_year = input("Enter your birth year:")

age=int(current_year) - int(birth_year)

print(name, " Your age is : " , age)

Note that the int() function is used in the line 
where the calculation is taking place.
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	� Open IDLE3 and open a new editor using the 
option File → New File.

	� Type the program without making mistakes.  
(Fig 3.6)

	� Give file name and save the file using the option 
File → Save.

To run the Program in IDLE3

Python IDE, i.e., IDLE
We made the program in Text Editor. However, 

when preparing large computer programs, special 
software known as IDE (Integrated Development     
Environment) is used to help run the program easily 
and fix errors. The window of  IDLE3, an IDE for 
writing programs in Python, is given in Fig 3.5.

Fig 3.5  IDLE 3 Window

Open IDLE3 on your computer and check what 
features are available in it.

Don't you see features that help you create a new 
file, save it, and run the program?

Let’s Run the Program in IDLE3
The  program that we prepared earlier was run  in 

the terminal. Prepare and run the program in IDLE3 as 
shown below.

Python Operators

Operators that can be applied to 
different data and variables in 
Python.
1.	 Arithmetic Operators:- 

For doing mathematical 
operations
Addition               	 +
Subtraction           	 -
Multiplication      	 *
Division	     	  /
Modulus	     	 %

2. 	Assignment Operator:--  to 
give a value to a variable = is 
used.
Eg; Mark=50

3.	 Comparison Operators:- To 
compare values:
Equal to	           		  ==
Greater than		  >
Less than			   <
Greater than or equal 	 >=
Less than or equal     	 <=
Not equal 			   !=

4.	LogicalOperators:- For 
Combining multiple 
statements :

	 and, or, not
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	� Then run the program by clicking Run Module 
from the Run menu.

Fig 3.6  Program made in IDLE3

Fig 3.7  Output Window of the Program Made in IDLE3

While running the program name, year of birth 
and current year are given as input. Didn’t you get the 
output  according to the given data?

Conditional Statement
Didn't you see from the schedule given at the 

beginning of the lesson that Sandeep gets up and does 
other things on holidays unlike normal days? 

That means, in certain days he works in one way 
and in other days he works in another way.  Similarly in 
computer also, in some cases  the flow of the program 
has to be varied depending on the conditions .

This is referred to as branching in programming 
methodology.

For example, during our school’s sports fair, 
children compete in different categories based on 

To the  
railway station  

turn right.
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their age. Those aged 14 years and above are placed 
in the junior category, while those under 14 fall into 
the sub-junior category. Let’s see how we can modify 
the program to display the category based on the age 
calculated in the program.

The if...else statement (condition) is used to 
check whether a specific condition is satisfied or not. 
If the condition is met, the program executes one set of 
instructions; otherwise, it follows a different path.

The way to type if...else statement is given below.                                           

if <condition> :

 		  statements for condition true

 else:

            	 statements for condition false

In our program, if the age is 14 years or older, the 
program must print the category as Junior, otherwise 
print the category as Sub-Junior. Then, It can be written 
using conditional statement as given below.

if age>=14:

 		  print(“Your are in Junior Category”) 

  else:

 		  print(“You are in Sub-Junior Category”)

Let's add these lines and run the previously 
prepared program.

 name=input("Enter your name:")

 birth_year=input("Enter your birth year:")

 current_year=input("Enter current year:")

 age= int(current_year)-int(birth_year)

 print(name, "  Your age is : " , age)

 if age>=14:

 	     print("Your are in Junior Category") 

Syntax

Each programming language has 
its own terminologies and rules for 
writing programs. This is called 
syntax.

Pay special attention to the 
indentation of the line after  
if <condition>: which is executed 
when the condition is met, and 
line after else: statement which is 
executed when the condition is not 
met.

Python statements should be 
written using lowercase letters of 
the English alphabet.  It is part of 
the syntax of Python language.
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 else:

 	    print("You are in Sub-Junior Category")

Fig 3.8  Output of the Program Using if...else

Flow Chart

Here, we have checked only one condition. In 
some cases, if the first condition is not met, it is to be 
checked if other conditions are satisfied.

For example, those above 16 years should be 
categorized as Senior, those above 14 as Junior, those 
above 12 as Sub-Junior, and those below 12 as Kiddies.

Look at the pictorial 
representation  (Flowchart) of 
the program that we made. 
Such a diagrammatic 
representation is helpful in 
analysing and solving large 
and complex problems easily.
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To check these multiple conditions, the if...elif...else 
format can be used, as shown below.

if age>=16:

 	        print("Your are in Senior Category") 

elif age>=14:

 	       print("You are in Junior Category")

elif age>=12:

 	      print("You are in Sub-Junior Category")

else:

       print("You are in kiddies Category")

Modify and run the program accordingly.

Loop Statements
Now, our program can calculate a person's age by 

taking the name, year of birth and current year and print 
the age category.

Suppose more than one child from a class 
participates in the school sports meet. What can we do 
to change this program to find the age and category of 
all of them? 

The number of lines should repeat, as many times 
as the number of children participate in the competition,   
right?

 Loops statements can be used to give instructions 
in this case.

There are mainly two types of loops in Python.

1. while loop 

2. for loop

while loop
The syntax of while loops is as follows.

while <condtion is true> :

	     statements to repeat

How many  
rounds until  

now?
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Suppose three children from our class are 
participating in the sports fair. Let's see how to do it 
using a while loop.

We can add a variable called count in the program. 
Initially its value can be set to zero. 

	 count = 0

For each repetition, the value of the variable  
count is to be incremented by 1.

For this we can use the code

	 count=count + 1

A total of three children are participating. Only 
when the count is less than three it should repeat. If it is 
3 or greater than 3 the program should end.

Then the condition for checking statements in 
while loop is count < 3.

That is,

while count < 3 :  

Now add the required codes and rewrite the 
program as shown in figure 3.9.

Did you note that statements to repeat are written 
one indentation away from the while block?

Fig 3.9  Python Program Using while Statement.
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Now run the program.

The program ends when three children's data is 
entered, right? Why is it so?

	� When the program starts, the value of the  variable 
count is zero.

	� Each time the code in the while block is executed, 
the value of count is incremented by one.

	� When repeated three times, the value of count 
becomes 3. Then the condition count < 3 is not met 
and the program ends.

Consider rewriting the program to accept number 
of children as input when this program runs (Fig 3.10).  
The variable no_of_students is used here to take the 
number of students as input.

Fig 3.10  Program that Accepts the Number of Students as Input

for loop
Another technique for handling iteration statements 

is for loop.

Consider a Python program prepared using a while 
loop to print the numbers from 1 to 100 on the screen.

count=1

while count <=100:

	     print(count)

	    count = count +1

Difference between =, = =

= operator is used to assign a value 
to the variable

Eg: price=200 means to add the 
value 200 to the variable price.

The == operator is used to check 
whether the right and left sides are 
equal.

Eg: price==200 checks if price is 
200.
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Now write and run this program in IDLE3.

Now, see the same program written using a for 
loop.

for count in range(1,101):

	    print(count)

Did you type and run the program?

What are the differences between while and for 
loops? See Table 3.1.

while for

Initial value is given to the variable count. 
(count=1)

All these are indicated in one line.

Given the code to increment the value 
(count=count+1)

for is used along with range.  

for count in range(1,101):

Given Code to check condition. 
(count<=100)

Table 3.1  The difference between using while and for loops.

	� In Python, range is used to arrange a set of numbers systematically. 

	� If range (10) is given, the decimal numbers from 0 to 9 (0, 1,2,3,4,5,6,7,8,9) are available 
for further computation.  

	� range(1,10) gives the 9 numbers from 1 to 9 (1,2.,3,4.5,6,7,8,9).

	� range(1,20,2) gives the odd numbers from 1 to less than 20 (1, 3, 5, 7,9, 11,13, 15, 17, 19).

	� That means the sequence of numbers will increase by two.

The Statement range

Now we have come across some programs 
prepared using Python language.

As we have just done, is it possible to get text 
output only using Python? 

For example, if you want to draw a picture on a 
computer, what software do you usually use?
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	� Gimp

	� Inkscape

	� ................................

Can you run a program that draws a picture?  let’s 
examine.

Python Graphics
Not only text, but Python can also draw images 

and geometric shapes, by providing graphical output as 
well. Python has library modules to meet various needs. 
By using the turtle graphics module, you can create 
programs that generate graphical output in Python.

To draw a line in turtle, we use the command 
forward. 

 If we are using this single command ,

from turtle import forward can be typed at the 
beginning.

Open IDLE3 and run the python program given 
below (Fig. 3.11).

Fig 3.11  Python program for drawing a line.

Python Modules
Modules are Python files that contain functions, variables, and classes for specific purposes.
Modules can be included in the program as needed using the keyword import.

Some python modules

os - For functions related to the operating system

math - For mathematical operations

Eg: sqrt,sin,cos etc

turtle - graphics, drawing

datetime - those things related to time and date
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A 100 pixel long line appears in the graphics 
window ( Fig 3.12).

Fig 3.12  Python Graphics Window.

Add the statement  from turtle import *  at the 
beginning of the program to add all the functions and 
classes available in the turtle module to our program.

You have seen that the forward instruction can be 
used to draw a line. 

The command right(90) can be used to rotate 90 
degrees  to the right.

If so, what instructions should be given to draw 
the shape of a playground with 100 units long and 100 
units wide? ( Fig 3.13).

Fig 3.13  Program to Draw Playgound with 100 Unit Length  
and 100 Unit Width.

To turn 90 degree right 
right(90). What about 

left?
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In this program, the instructions to move forward 
100 units and turn right 90 degrees are executed four 
times to produce the shape of a rectangular playing 
ground.

What colour are the shapes we have now?

Open IDLE3 and try typing and running the 
programs shown in Figures 3.14 and 3.15 one by one.

Fig 3.14  Program 1 to draw shape using turtle graphics

Fig 3.15  Program 2 to Draw Shape Using turtle graphics

See the outputs of the programs. Did you notice 
the use of forward, left, right, circle, range commands ?

Now, use these programs to draw different shapes 
and observe the output and  complete  Table 3.2.

Make changes in the colour of the line, length, 
number of sides, angle and radius of the circle .

We can draw patterns 
easily using Python 

Graphics.
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Python Code Use

color("red")

circle(100) To draw a circle of radius 100 unit.

left(45)

right(45)

range(8)

Table 3.2  Python Graphic Codes and Uses

Lists in Python
Using the option list in Python, it is possible to 

store different data in a single string.

See how the names of the various colours are 
included in the variable colors. 

colors = [“red”, “yellow”, “blue” , “green” , 
“orange”,“violet”]

The data in a list can easily be used in a program 
that uses the for loop command. Try running the 
program given below.

	 for clr in colors:

	      print(clr)

A Python program to create circles of different 
colours and radius is given in Fig 3.16. Type this 
program and run it and observe the output.
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 	 a=100 
a=a+25 
print(a)

	 What will be the output of this program?

	 	Which is the python program to print even numbers from 20 to 40?

a) for i in range(20,42,2):
	 print(i)
b) for i in range(20,2,42):
	 print(i)
c) for i in range(20,42):
	 print(i)
d) for i in range(1,2,20):
	 print(i)

Let's Assess

Extended Activities

1.	 Create and print various lists in Python.

	Names of friends

	Names of flowers

	Names of planets in Solar System

Fig 3.16  Python Program for creating Circles with different colours and radius
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

2.	 Write a Python program to find the area of a field if its length is 120 m and width is 50 m.

3.	 Write a Python program that takes three different numbers as input and print the largest 
number among them.

4.	 Take the score obtained by a student in a subject (out of 100 marks) as input and write a 
Python program to calculate the grade based on the following conditions.

Score>=90 Grade= A+

Score>=80 Grade=A

Score>=70 Grade=B+

Score>=60 Grade=B

Score>=50 Grade=C+

Otherwise print "Not Eligible"

5.	 Draw a rectangle with a length of 200 units and a width of 100 units, using blue, green, red, 
and yellow colours for the sides.
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Chapter 4
Cyberspace 

How about exploring the world described in the 
poem?

Nowadays, the internet is widely used for various 
purposes, including education, entertainment, and 
business, rather than just communication. With this 
advancement, people have embraced a collaborative 
culture, working together across distances. The internet 
has become an essential part of modern civilization.

Haven’t these continuous advancements in 
information technology shaped many aspects of our 
relationships and habits? Write them down in your 
notebook.

	� Goods being delivered to homes without visiting 
shops has become common.

I alone exist in this monitor of mine 
In the Cyberspace that infinitely grows 
On this solitary journey into alien universe 
Leaving this earth of mine.

Cybermoon 
(Alamcode Leelakrishnan)
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Digital Footprint
Digital footprint is the set of information (trace of information) created while using the 
Internet.  This includes the websites we visit, the posts and photos we share on social media, 
the apps we use, and the data we provide for online services. A digital footprint is any trace 
of our online activity that can be seen or followed by others.

Cyber Identity
A person’s identity in the cyber world is their digital representation. 
It is not confined to a single ID but is shaped by the information 
and activities linked to their online presence. Numerous factors 
contribute to digital identity, including social media profiles, search 
engine activity, visited websites, phone numbers, gaming IDs, the 
identification number of the device used, location, and more.

	� Entertainment like movies, music, and sports is now 
just a click or tap away.

	� ...................................................................................

	� ...................................................................................

	� New types of crimes have emerged.

The way we handle money transactions has 
changed, and now we can communicate with people 
across any distance through sight and sound. Amazing, 
isn’t it?

You know how deeply the internet has become a 
part of our lives. Whenever we transact online, we step 
into a unique digital space. This virtual space where 
the computers, phones, servers, other digital devices, 
networks, and the information transferred through them 
are all linked together is called cyberspace.   

Whenever we interact on the internet, whether 
it’s performing a search, liking a favorite post, or any 
other activity,  our footprint is imprinted there. This is 
known as a digital footprint. In cyberspace, there are 
friendships, quarrels, and conflicts, just like in real life. 
Everyone who engages there creates a cyber identity.



69

Cyberspace

Information & Communications Technology-10

Have you ever stepped into cyberspace?

Table 4.1 gives some of the contexts in which we 
interact with the cyber world. Consider the tools and 
information involved in these interactions. Add the 
missing items to the list.

Contexts Relationship with the Cyber world

Purchase and recording of goods from ration 
shop.

E-POS device, Fingerprint.

The information being printed in the passbook 
using the printer installed in the bank.

Printer and account details connected to 
the network.

Watching online class.

Searching for routes on map software while 
travelling.

Requesting your favourite music and controlling 
of home appliances with voice command.

Home appliances, voice messaging, 
Internet of Things.

Playing online games with a distant friend.

Smartwatch that tracks health information such 
as heart rate, sleep patterns etc.

Smart watch and mobile connected with 
it, Internet and health data.

Table 4.1  Some Cyber interactions in everyday life.

Internet of Things (IoT)

The Internet of Things (IoT) refers 
to a network of physical objects 
connected to the Internet. These 
objects are equipped with sensors 
and software, enabling them to 
collect data, communicate with 
each other and interact with their 
environment

Does the list cover all of your interactions in 
cyberspace? In what ways do we access the cyber world? 
Mobile phones, smartwatches, passbooks, printers, and 
IoT devices serve as both direct and indirect gateways 
to cyberspace, don’t they?

We’ve frequently mentioned the terms internet, 
cyberspace and cyberworld in many occasions. While 
these are interconnected, it’s important to understand 
that they are not the same.
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Cyberspace is an imaginary digital realm where 
online activities and interactions occur. Similar to the 
universe with its stars, galaxies, and planets, cyberspace 
encompasses the internet, digital systems, and  
exchanges of ideas. As we know that the internet is 
a global network of interconnected computers that 
communicate using various protocols. It relies on 
physical infrastructure such as servers, routers, and 
data centers, connected by cables and satellite links. 
The internet is a component of the broader concept of 
cyberspace.

The cyberworld is a unique environment within 
cyberspace. It refers to specific virtual spaces such as 
virtual reality platforms, online multiplayer games, 
or immersive simulations. When we log into an 
online game or a virtual reality platform, we enter the 
cyberworld created within cyberspace.

What else can we explore about cyberspace? 
Let’s find out!

Belongings in Cyberspace
We have understood that a person establishes a 

relationship with cyberspace through his interactions 
there. Now let's check what are the belongings in cyber 
space.

Cyberspace is bounded with many things, 
such as the Internet, different hardware, network 
protocols, information, databases that store it, web 
pages, and security systems. These are called Cyber 
Infrastructure. In short, we, the contributors of digital 
data, actively engaged in an uncontrollably growing 
cyberspace, are both its nurturers and beneficiaries.

There are many studies going on to make the 
experience of the real world possible in the cyber world. 
As a result of this, the Metaverse came into existence 
with the help of artificial intelligence technology.

Wow! So we are 
in the same World.

No, in different 
spaces created by 
the Technology.
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Let's Learn through 
Games

What if learning mathematics like 
playing a video game?  As you 
get the correct answers, you can 
proceed to the next level. You can 
get your friends to help.

Gamification refers to the 
integration of game design 
elements into learning 
environments. By introducing 
elements like points, badges, 
leader boards and challenges, it can 
turn conventional style of learning 
into a fun and interactive process. 
Metaverse can make gaming 
experiences more engaging and 
realistic.

Metaverse
Think of a the character you've read in your life 

that sticks out in your mind, or from your favourite 
cartoon/gaming experience.

	� What if this character could tell us stories from the 
cyber world?

	� What if this character could come directly into our 
classrooms?

	� What if we could take a virtual tour of a historic site 
while sitting in our school lab?

Metaverse is the system that provides us with 
such an experience.

The Metaverse is an immersive platform used 
for gaming, social media, shopping, education, and 
much more. It functions as a vast virtual world where 
you can explore, meet others, play games, and work—
all through the internet. The Metaverse integrates 
advanced technologies like Augmented Reality (AR), 
Virtual Reality (VR), Artificial Intelligence (AI), and 
Blockchain to create an artificial world similar to the 
real world. Avatars represent the user's presence in the 
Metaverse.

The Story of the Word
There is a famous story about cyberspace.

Cyber experts Bobby and Jack try to extort money 
from the powerful Chrome of the cyber underworld. 
Chrome is a woman who has achieved fame and fortune 
through illegal activities. Moreover, they have a robust 
computer network. Bobby and Jack use a sophisticated 
hacking tool to infiltrate Chrome's computer network.

Avatars in Cyberspace
Avatars are digital representations 
of users often used in virtual 
environments such as online games, 
social media platforms, and virtual 
reality experiences. In the digital 
world, people can communicate 
and interact each other with their 
avatars.
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Hacking

Hacking refers to unauthorized 
access to a computer or network, 
often considered a cybercrime. 
It can involve stealing sensitive 
information, damaging computer 
systems, or exploiting systems for 
malicious purposes.

On the other hand, ethical hacking 
involves using hacking techniques 
to identify vulnerabilities in 
computer systems or networks, but 
only with the owner's permission. 
The goal of ethical hacking is 
to enhance security and prevent 
cyberattacks. Unlike unauthorized 
hacking, ethical hacking is legal 
and not considered a crime under 
current laws.

Hacking is like breaking into someone’s house 
without their permission. In the story, Jack and Bobby 
manage to steal a lot of digital assets from Chrome. But 
soon, Chrome gets caught by the police. Meanwhile, 
Bobby and Jack face big problems because of their 
actions in cyberspace. As they go deeper into the 
dangerous world of hacking, they learn some important 
lessons. The story is full of interesting events and 
characters that make it exciting to follow.

The story is not being detailed in full here as it 
may become a Spoiler.  

Have you heard of Spoiler?

I have seen  
this film,  

shall I tell the  
upcoming twist ?

Spoiler alert !   
No. 

I shall see.

A spoiler is a term that refers to information that 
reveals the climax or main plot of a movie or novel.
When introducing works in cyberspace as videos, 
blogs, or podcasts, warnings called 'spoiler alerts' are 
used.
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The story of Burning Chrome, mentioned above, 
was written by William Gibson in 1982. Following this, 
he published another novel in 1984 titled Neuromancer, 
which popularized the term "cyberspace." This science 
fiction (Cyberpunk) work explores futuristic cities 
dominated by advanced computer technology.

Have you understood the concept of Digital 
Assets mentioned in the story?

Digital Assets refer to financial assets that 
exist only in digital form and do not have a physical 
existence. Despite being intangible, they hold value 
equivalent to money and can be traded. Examples of 
digital assets include digital currencies, digital wallets, 
points earned through online shopping, NFTs, domain 
names, and software.

NFT

The full form of NFT is Non-Fungible Token. It refers the valuable things in the cyber world. 
Such objects are proprietary. You can buy them for money and sell them to someone else. 
Some examples are digital art, digital versions of music, paintings, photographs, videos, and 
rare in-game items or characters.

Cryptocurrency is a digital currency.  Transactions in this are secured using a technology 
called cryptography. Blockchain technology is also employed to record transactions, and 
making them transparent and secure. Unlike traditional currencies such as the rupee, dollar, 
or euro, which are issued and regulated by governments, cryptocurrencies operate on 
decentralized networks powered by advanced technology. Examples of cryptocurrencies 
include Bitcoin, Ethereum, and Litecoin.

Cryptocurrency

Let's Prepare a Table of Digital Assets
We now understand what digital assets are. We all 

deal with various digital assets in our daily lives. Table 
4.2 contains details about some of these digital assets. 
Review the table and fill in the missing information.
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Expand the list by finding more digital assets you 
manage.

Information diversity in cyberspace
You have learned about the diversity of  

information in cyberspace from previous classes. 
In the early days, most of us were consumers of 
cyberspace information, but today, we all are producers 
of information. Each one of us is participating in the 
creation of information in cyberspace through different 
interactions in every moment.

Fig 4.1 provides some examples of how 
information is produced in cyberspace. Examine the 
figure and find out the types of information in these 
cases and record it in the notebook.

Digital Assets Type Purpose

Audacity Digital Media

Khan Academy Online Educational Platform
Free online learning 
resources

Krita Digital Art

OpenSea NFT online market

www.samagra.kite.kerala.gov.in Domain name

e-Books

Table 4.2  Digital assets and types
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a) Chat Including Different 
Types of Data.	

b) Information in Online Map.

c) Review of a Product in a Shopping Site.

Fig 4.1  Different Data Created in Cyberspace
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(a) : Location, Text, Image, Emoji

(b) : Information created while using online map.

(c) : ………………………………

Data is often described as the currency of the 21st 

century or the oil of digital wealth. The image, voice 
and video files that we send through email and other 
messaging apps, information generated by  IoT devices 
and various sensors are all added to cyberspace. The 
comments, likes, shares and reviews we give on 
shopping sites are also data.

Notice the map data in Fig 4.1 (b). We all use 
online maps while travelling. The places visited on the 
way, the time we spent, the places where the vehicles 
were going slower... all such information can be 
indirectly generated by the apps we use.

Due to the advancement of technology, the amount 
of digital data around the world is growing rapidly.  
Studies published in 2024 indicate that the amount 
of digital-based data generated by social media,  
e-commerce, and the Internet of Things (IoT) 
will be approximately 2.5 quintillion bytes 
(2,500,000,000,000,000,000 bytes) per day. The 
interesting fact is that the major share of this data 
has been created within the last few years only.  The 
information that is being produced in such a large 
quantity, quickly and in a reliable manner is called Big 
Data.  Big data refers to very large and complex datasets 
that traditional data processing software cannot handle 
efficiently.

Data Collection
Explicit data collection occurs when a user knowingly provides their information, such as by 
filling out forms, signing up for accounts, or giving consent for data collection.

Implicit data collection refers to information gathered without the user explicitly providing 
it. This includes data like browsing history, location information, and details about devices 
connected to the internet
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Shall check  
online for  

more details

While Using the Information from 
Cyberspace

If you were asked to write an essay on a topic 
related to a lesson, where would you search for 
additional information?

	� Library Books

	� Newspaper

	� Periodicals

	� Wikipedia

	� ….............................................................…………..

The information gathered from these sources 
can be organized and used to form your essay. You can 
utilize one or more of these sources for this purpose. 
These sources are referred to as sources of information.

What can we do with the content available?

1.	 The essay can be completed by arranging the 
available information in a specific order.

2.	 Based on the available information (references), we 
can rewrite it in our own words.

3.	 ................................................................................

As a student, the second method is likely the best, 
right? This approach offers more learning opportunities, 
as it allows us to incorporate our own perspectives and 
avoid using incorrect facts. You can also create tables, 
graphs, and images based on the information you've 
gathered.

Will this complete our essay? Not yet. We must 
properly record the source of the information we've 
used. Only then will our work be complete. The original 
authors from whom you have got the ideas, theories, 
figures, and findings for the development of our  work 
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should be acknowledged. It is actually an honour to 
their intellectual contributions and efforts.

The details of the sources of all the information 
used in our work are called References. The name of 
the author, date, place of publication, etc., provide the 
complete details so that readers can find and verify 
the exact sources of information. Publishing someone 
else's study or work under your own name without 
citing the sources is equivalent to theft. The act of 
presenting someone else's ideas, expressions, or work 
as your own is called plagiarism. There are efficient 
software tools available for detecting plagiarism. One 
may face disciplinary action if plagiarism is found in 
works submitted as part of a course or study.

Paddy and Chaff in the Fields of Knowledge
You might already be familiar with fake news. 

We learned how to identify it from the textbooks of 
previous classes. But even beyond fake news, there 
are other situations in cyberspace that can spread 
misinformation. For example, articles about medical 
treatments written by people without proper expertise, 
or information that has become outdated due to recent 
discoveries or changes, can be shared wrongly. So, 
when sharing information online, remember:

	� The information must be authentic.

	� It should be from reliable sources.

	� It must be up to date.

	 It's important to pay close attention to these 
things to avoid spreading wrong information.

Observe the Fig. 4.2 given below.  It provides 
scientific explanations to counter the unreliable 
information being spread.

Have you  
included  

References  
in the work ?
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a) Scientific article against the propaganda that 
vaccination and autism are interrelated.

b) Message by UNICEF against the propaganda that Corona 
and 5G are related.

Fig 4.2  Some Scientific Explanations against Misinformation

False propaganda that vaccination and autism 
are related has hindered vaccination efforts in many 
countries and has become the reason for the spread of 
the disease.  However, numerous studies have shown 
that there is no connection between vaccines and 
autism. Similarly, there have been false claims linking 
5G technology to the Covid-19 pandemic, All these 
were widely circulated through social media.

What can you do at school to raise awareness 
about fake news ? Discuss this with your friends and 
come up with ideas to help spread the truth.

Reliable Sources
What do you usually do to find information 

quickly in cyberspace?

•	Use Search engines

•	Use AI systems

But is all this information accurate?

Information published on the internet can 
sometimes contain errors, biases, inadequate research, 
or outdated knowledge. To avoid these issues, it is 
important to rely on reliable sources of information.

Yes, I saw.  But be careful.   
All those in Internet may  

not be true.

Search for reliable sources in 
Scholarly Communication.  Only 

the checked ones by experts  
will be published here.

Have you seen the video I have 
sent ?  Are the aliens on Moon 
true ?

But how to know whether these 
creatures are true ?
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When searching information for educational, 
research, scientific, or industrial purposes, it is essential 
to use trusted sources. Some examples of reliable sources 
include reports from scientific conferences, scientific 
journals, books, theses, and reports from recognized 
agencies. These are documents certified and published 
by experts or scientists in their respective fields.

Using websites like www.scholar.google.com and 
www.semanticscholar.org, you can find only credible 
scientific publications. You can learn more about this 
by scanning Fig 4.3 in the SAMAGRA Plus portal.

Now, use search engines like Google Scholar or 
Semantic Scholar to search for the following topics and 
observe the search results.

You can note down the differences in your 
notebook.

•	Future of cryptocurrency

•	Hidden figures in history

Fig 4.3  How to search for science publications - Video Link

Share Information Carefully
We have already discussed different types of data 

collection in cyberspace. But have you ever thought 
how implicit data, which is not directly collected from 
the user, is gathered?
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This is done by tracking a person’s behaviour 
and interactions in cyberspace. In simple terms, every 
action we take online is monitored using different 
technologies.

For example:

	� Which websites do we visit?

	� Who do we become friends with?

	� What types of posts do we like and share?

	� What products do we buy?

	� ...................................................................................

	� ...................................................................................

In this way, our likes, opinions and relationships 
are recorded in many places.

These surveillance systems, in turn, use these 
direct and indirect information about us in a variety of 
ways.  

Although we like to share our achievements with 
others, we should take care to keep our passwords 
and personal information confidential.   When sharing 
sensitive details like passwords, ATM PINs, etc., in the 
cyber world, we must be more vigilant and cautious. 
Below are some confidential details that should be kept 
private:

	� Photo

	� Bank details

	� ...................................................................................

	� ...................................................................................

	� ...................................................................................

Don't you think that we need a lot of care in our 
every interaction in this world of illusion?
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Dangers of Excessive Use
Has the excessive use of internet bothered you 

in any way? Let's come back to the story of Burning 
Chrome that we met earlier. The characters in the story 
live in a hyper-technological society, where interactions 
with cyberspace (and each other) are mediated by 
machines. Such an intense induction with technology 
creates a sense of emotional and social alienation. These 
often create mental or physical ailments. Check figure 
4.4, some of the problems with excessive cyber travels 
are illustrated in the figure.

Be Careful
FOMO (Fear of Missing Out)
Fear of missing out on favourite important events or social 
interactions due to constantly checking social media.

Gaming Disorder
Excessive gaming. Due to this, daily routine activities and 
studies are not attended.

Cyberchondria
The practice of madly searching for medical information 
online due to the fear of having symptoms of diseases.  This 
leads to unnecessary anxiety about health conditions.

Nomophobia -  No Mobile Phobia
The over anxiety when not having mobile phone or other 
devices with internet connection.

Tech Neck
The condition results from prolonged staring at smartphones or tablets, causing 
neck pain, tension and discomfort.
Obesity and Sedentary Lifestyle
Spending too much time on gadgets can lead to reduced physical activity, weight 
gain and lifestyle diseases. 

There is a Solution
	� Limit screen time

	� Disconnect from the digital 
world every now and then  
(Digital Detox)

	� Just keep a careful online 
presence alone.

	� Follow healthy sleeping 
habits..

	� Maintain strong personal 
relationships to balance online 
interactions.

Fig 4.4  Problems Caused Due to the Excessive Use of Internet

What other problems can arise due to unrestricted 
internet usage? Discuss it with your friends and write it 
down in your notebook.



83

Cyberspace

Information & Communications Technology-10

Dear Netizens, brothers,

   Our etiquette in the cyber world 
is called Netiquette.

Let’s troll him.

Have you ever 
thought how much a 
troll hurt someone ?

Cyber Etiquette
Human interactions are based on many rules, 

guidelines, and social norms. As citizens of the 
boundless cyber world, where there is a lot to give and 
take, we too have certain moral responsibilities.

Netiquette refers to a set of rules for good 
behaviour on the Internet. It’s important to be as kind 
and respectful to others online as we are offline.

	� Do not share harmful or hateful messages, comments, 
trolls, posts, or news with others.

	� Record disagreements in a respectful manner.

	� Avoid sharing other people's personal information.

	� Follow the rules of the websites or forums you use.

	� If you notice inappropriate content in cyberspace, 
report it to your teachers or the cyber police.

 	 What is the name given to the information that is being produced in large quantities, rapidly 
and in different ways in cyberspace?

	 a)  Digital Footprint		  b)  Bigdata
	 c)  Cyberdata			   d)  Indirect information

Let's Assess
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	 	Identify the odd one which do not include in Digital Assets.

		 a)  School Computer Lab		  b)  Software

		 c)  Reward point from Bank	 d)  Digital Image

Extended Activities

1.	 There are many words that have taken on different meanings over time.  Some examples 
are - file, virus, attachment, remote, spam, selfie, hashtag, meme, Playground, troll, cyber 
pollution, dark web... Find more such words. Classify which of these words are associated 
with cyberspace.

2.	 Organize a seminar in school on the dangers of excessive internet use.


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Chapter 5
Make the Web Look Stylish 

Fig 5.1  Webpage Design - Sample 1 Fig 5.2  Webpage Design - Sample 2

Two web pages with the same content are shown 
in the image. Which one seems more appealing?

Doesn't the webpage in Fig.5.2 look better 
organized?

The arrangement of content, the choice of colour 
schemes, the selection of elements to be included, and 
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Table 5.1  Differences between webpages

functionality are all important aspects to consider when 
designing a webpage. If a product has a good design, its 
appeal will naturally increase, right?

Exploring the Differences Between 
Webpages

What are the differences between the two 
webpages shown in the image? List them. (Table 5.1)

Figure 5.1 Figure 5.2

Texts in same colour Text in different colours

Background color for the page

We have learned how to create a webpage in our 
previous classes. To create the webpage in Figure 5.1, it 
is enough the HTML techniques we have learned so far. 
However, the webpage in Figure 5.2 has been created 
by incorporating a technique called 'style.'

We have learned how to make text attractive and 
convenient using style option in wordprocessors. Such 
styles can also be applied for designing webpages.

How to add styles to a webpage? Let's check.

Let's Find the Difference in HTML Codes
The HTML code for a similar small section from 

two webpages is given below. Examine the differences 
between them. (Fig 5.3, 5.4)

Fig 5.3  Webpage Created without Style Codes
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Division Tag (div)

The <div> tag is one of the most 
useful tags when designing a 
webpage, as it helps to divide the 
code in a webpage into different 
sections (divisions). It also allows 
various elements to be organized 
neatly inside this tag.

Fig 5.4  Webpage Created with Style Codes

In Fig 5.4, there are additional codes starting 
with "style" in blue colour. These are codes that help in 
adding styles to the web page. Let's see how they make 
the web page attractive.

These webpages are provided in the folder; 
Class_10/Webdesigning under School_Resources 
with the names One_ product_basic.html and One_
product_ designed.html. Open and analyse them in a 
web browser as well as in a Text Editor.

Let’s Find Style Properties
Haven't you examined the source code of the 

web pages? Now, find the styles given to each HTML 
element/tag shown in Fig 5.4 and complete Table 5.2 
below:

Tag/Element Style Code
<h2......>Featured Products</h2> style="color: #0000FF;"
<div>

<h3......>Hand-made Soaps</h3>
style="text-align: center; background-color: 
#FFD700; color: #333333; font-weight: bold;”

Table 5.2  Style Codes

HTML Element and Style Code

An HTML element usually consists of an opening tag, a closing tag, and its content. 
<h2>Featured Products</h2> is an HTML element. Here, <h2> is the opening tag, and  
</h2> is the closing tag.  However, tags like <hr> for drawing a horizontal line and <br> for 
a line break are elements that do not have closing tags or any content. The style code is added 
along with the opening tag of an HTML element.
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Colours
You can use either colour names or 
hexadecimal codes to set colours. 
For example, to make the text 
blue, you can use color:blue or 
color:#0000FF. When colouring 
an image in Inkscape, check if 
these colour codes are available in 
the Fill and Stroke window.

The style attribute is used here to apply styles to 
an element. Along with this, instructions are provided 
on how the element should be arranged on the webpage.

The style attribute is added in a similar way to 
how we add attributes like colour, font, and size to the 
font tag when creating a webpage in HTML. The main 
goal of this is to make the content of the webpage look 
more attractive. The styles written this way are called 
Cascading Styles.

Structure of Styles
	 Given below is the code used to style the <h2> 

tag in the webpage in Figure 5.4.

style=“color: #0000FF;”

What would be the purpose of this?

The content inside the <h2> tag should appear in 
blue colour (#0000FF) when displayed in the browser, 
right?

Examine how the font size, background colour, 
paragraphs, and divisions (<div>) are configured on 
this webpage using the style attribute.

When Using the Styles

Style instructions consist of two parts: the property of the style and its corresponding value. 
For example, the instruction in the style attribute of the h2 tag is color:#0000FF; Here, 
color represents the property of the tag element, and #0000FF is the value assigned to that 
property. A colon (:) is used to separate the property from its value, and a semicolon (;) is 
added at the end to complete the instruction.

Tag    Attribute	    Property   Value

<h2 style="color: #0000FF;". Featured Products <h2>

Style Declaration
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Do you understand the structure of styles? let’s 
analyze the remaining style properties in the HTML 
code shown in Fig 5.4 and complete Table 5.3 by 
identifying the features.

Style Property Value

Align the text to the centre text-align: center;

Adjust the thickness of the font font-weight:

Table 5.3  Style property and its value

Add More Content to the Webpage
How can we add more content to the webpage we 

just examined?

The webpage One_product_designed.html 
shown in Fig 5.2 contains details about the product 
"Hand-made Soaps." Similarly, we could expand this 
page by including information about other products 
like notebooks, LEDs, washing powder, and candles.

The style applied to the "Hand-made Soaps" 
section can also be used for the additional sections. But 
how can we do this?

For example, let’s say we want to add a product 
called "Hand-made Notebooks" priced at Rs.45 to the 
webpage. Open the file One_product_designed.html 
from the Webpagedesigning folder in a Text Editor. 
After the existing content, just copy and paste the code 
for "Hand-made Soaps," and update the image name, 
product price, and other details as needed.

Some images required for our webpage are 
included in the Webdesigning folder. Add the name and 
necessary details of the image file containing notebooks 

Background-color, color

The style property used to set the 
background colour of an element is 
background-color.

The color property is used to 
define the colour of an element's 
content (foreground), means the 
text colour neatly inside this tag.
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to the HTML file, and save the file as Two_products.
html (Figure 5.5).

Fig 5.5  Code with Two Products

By including as many products as needed, the 
page can be expanded. You should open the page in a 
web browser and check how they are displayed.

Repetition of Styles
Now, check which tags in the Two_products.html 

page have repeated styles.

In the newly created HTML page (Two_products.
html), examine which tags have the same styles applied.

	 • div

	 • h3

	 • p

	 Refer to Figure 5.5. Style code has been given 
each time to style these tags. Here, even if you want to 
give the same style to the same tag in different places, 
you have to repeat the style codes.

Let's look at the inconveniences caused by this.

	� The size of the HTML program increases.

	� Maintaining the code is becoming difficult.

	� If changes are made to the styles, they need to be 		
made for every line.

	�  ..................................................................................

Wow! Adding more
 products will make

 the code huge!
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In short, this type of inline cascading style has 
limitations when used on pages with more content.

Digital Footprint
Inline cascading styles involve adding styles to a 
specific HTML element directly within its own 
HTML tags.

What's the solution for this?

Let's Avoid Repetition
Let's see how to give cascading style to content 

without repeating codes.

The problem of code repetition can be solved by 
defining all the styles for a tag in a separate section 
on the page and ensuring the tag automatically applies 
those styles wherever it is repeated.

Look at Fig 5.6. The features required for the 
<h3> tag are included within the <head> section at the 
beginning of the HTML page.

Beginning of CSS
CSS was introduced by the World 
Wide Web Consortium (W3C) in 
1996. The idea was proposed by 
Haakon Wiam Lee and Bert Bos.

Fig 5.6  The Style is Added Separately

By including style suggestions like this in 
an HTML page, what differences can be observed 
compared to what was done before?

	� Earlier, style was an attribute, but here it is a tag.

	� Here, the style instructions are given as the content 
of the style tag.
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	� The style is given inside the curly brackets {} within       
the <style> tags.

	� ...................................................................................

Thus, type selectors are styles that are intended 
to be applied to tags on a webpage. Open the Two_
products.html file and convert the style instructions 
used on that page into this format (see Fig 5.7). Save 
the file with a new name (Schoolshop_internalcs.html), 
then open it in the browser and observe.

Fig 5.7  Webpage  modified using internal cascading styles

Measurements of CSS
Different dimensions are used 
in CSS to specify the length, 
width, height, etc. of different 
elements. px is a measurement 
used in comparison to the pixels 
of a screen. Apart from this, 
centimeters (cm), inches (in) are 
also used. These are usually called 
absolute measurements.

Apart from this, relative 
dimensions like em and % are 
also used in CSS to enable the 
adjustment of web page content 
according to each screen.
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Here we have added the style inside the <head> 
section of the HTML file. Adding style in this way is 
known as internal cascading style.

Internal cascading style is more convenient 
compared to inline cascading style.

List the characteristics of the internal cascading 
style compared to the inline cascading style in the table 
(Table 5.4).

Internal Cascading Style

Internal cascading style is the 
method of adding styles for HTML 
elements within the <style> tag in 
the <head> section of the same 
file. Style instructions are given 
inside the {} brackets within the 
<style> tag.

Inline Cascading Style Internal Cascading Style

Each tag needs to be styled everytime. Need to style a tag once.

Codes are getting complicated.

Codes are getting longer.

Table 5.4  Inline Style and Internal Style

Cascading Style Sheets

Fig 5.8 Wikipedia Pages with Similar Styles

See Fig 5.8. These are screenshots of two different 
pages on Wikipedia. What are their characteristics?

	� The layout is similar.

	� ...............................................................................	
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Similarity in design can be seen across all 
Wikipedia pages. On many other websites, the layout of 
the main page is often used as a template for designing 
their associated pages as well.

Did Wikipedia make all its pages look the same 
by repeatedly using style codes on each page as in the 
internal style model, just like we did now? If it is so, 
these codes need to be used repeatedly across all of 
Wikipedia's millions of pages.

Cascading Style Sheets provide a solution to 
this. In this method, styles are created in a separate file 
(external style sheet) and applied to all the required 
web pages.

Let's Create a Cascading Style Sheet
Let's see how we can apply the styles specified 

within the style tag of the saved file, Schoolshop_
internalcs.html, to another page using Cascading Style 
Sheets.

For this, follow the steps provided below.

To Create an External Stylesheet

	� Open a new document in the Text Editor and type 
all the style instructions used in webpages in the 
document.

	� Save this file with the extension css (style.css).

	� Create a new HTML page (Schoolshop_ 
externalcss.html). You can prepare the new HTML 
file by removing all the style-related instructions 
inside the <head> tag from the previously created 
Schoolshop_internalcs.html file

	� Save the css file and the HTML file in the same 
folder.

	� Then, include the code shown in the image below, 
exactly as shown in Fig. 5.9, into the <head> tag 

CSS is an abbreviation for 
Cascading Style Sheets. 
Stylesheets are files that store 
the styles to be used on a web 
page separately by excluding 
the content. In webpages, all 
the cascading styles we use are 
combined into a single file, given 
a preferred name, and saved 
with a .css file extension. When 
creating webpages, it is possible 
to include all the cascading styles 
provided in this file using a 
single line of code, which is the 
advantage of this approach. The 
purpose of cascading style sheets 
is to describe how a page written 
in a markup language should be 
displayed. Cascading style sheets 
help avoid the repeated use of 
styles in webpage design, make 
coding tasks relatively easier, 
and bring beauty, and order to the 
design.

Cascading Style Sheets
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of the Schoolshop_externalcss.html file, where the 
CSS file is to be used. Save the file.

(In the filename section, we should include the name 
of the file we created, along with the .css extension.)

<link rel="stylesheet" type="text/css" href="filename.css">

Fig 5.9  Code to Link CSS File into a HTML Page.

Now open the file in a browser and watch for the 
output. Hasn’t the style appeared on the page?

Like this, include the styles from the CSS file to 
all the required pages.

Cascading Style Order

If an element has more than one cascading style, the order of precedence determines which 
style is applied.

See Fig 5.10. Here, notice the background colour (lightblue) given to the paragraph as an 
external style. At the same time, another background colour (hotpink) has been given to the 
paragraph as an internal style on the page. In this case, the background colour given as an 
internal style will be given to this paragraph.

Fig 5.10  Cascading Style Order

If the same element is given styles externally, internally, and inline, the browser's priority for 
choosing the style is given below.
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We have already learned how to add styles directly to an element’s opening tag and apply 
common styles to all elements using their tag name. In addition to these methods, there are 
other ways to apply styles without using tag names. You will explore these advanced methods 
in higher classes. Similarly, to make the webpage you created accessible to everyone over 
the internet, there are additional steps to learn. These too will be introduced in higher classes.

External
 Style

Internal
 Style

Inline
 Style

Highest
Priority

	� Which style feature is used to bring the text in a webpage to the centre of the page?

			  a) color: #a569bd;                            	 b) font-family: Gentium Basic;     
			  c) text-align: center;                         	 d) font-weight: bold;

	� <h3 style="text-align:center;color:#a569bd;">Hand-made Notebooks</h3>  
Which cascading style is used in this line?       

			  a) Inline				    b) Internal		
			  c) External				    d) Outline                  

	� While using external cascading style sheet, which tag can be used to include the stylesheet 
in an HTML page ?

	       a) rel           	      			   b) type            	      
			  c) css                     			   d) link

Let's Assess

Extended Activities

1.	 Create a webpage using CSS to promote the sale of native products and home-grown 
vegetables cultivated in your ward.
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

2.	 The text below is intended for designing a webpage to publish school news but is incomplete. 
Copy this code into a text editor, apply suitable styles, and enhance the appearance of the 
webpage.

	

	 <html>
		  <head>
		  <title>GHSS Alappuzha - School News</title>
		  </head>
		  <body>
		  <div>
		  <h1>Welcome to GHSS Alappuzha - School News</h1>
		  <p>Stay updated with the latest events, achievements, and announcements!</p>
		  </div>
		  <div>
		  <h2>Sports Day Highlights</h2>
		  <h3>Exciting Moments from the Field</h3>
		  <p>Our Annual Sports Day was a thrilling success, with students competing in various events 	

	        such as races, football, and long jump. Here are the key highlights of the day.</p>
		  </div>
		  <div>
 		  <h2>School Kalolsavam Highlights</h2>
		   <h3>Amazing Performances by Our Students</h3>
 		   <p>This year’s School Kalolsavam displayed incredible talent from our students.Various art 	

	 forms were showcased,leaving everyone amazed at the creativity on display.</p>
		  </div>
		  </body>

		  </html>
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Chapter 6
The World of Robots 

What do you see in the picture? It’s a robot 
cleaning the trash.

Have you seen robots ? In which fields are robots 
used?

	� In factories

	� In agricultural areas

	� For entertainment

	� ...................................................................................

	� ...................................................................................

Today, robots are used in various fields such as 
agriculture, vehicle manufacturing, space missions, 
and many others. Their use increases the productivity 
and reduces the workload on humans. Let’s explore the 
fascinating world of robotics.

How Robots Work
Have you ever thought about what robots are 

capable of? Robots can perform complex tasks quickly
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and accurately for extended periods without tiring. 
These machines come in different sizes and shapes, 
designed to suit specific tasks and environments. Robots 
can take forms such as small vehicles, birds, animals, 
human hands, and even full human-like figures.

Have you ever thought about how robots work? 
Robots recognize their surroundings and analyze the 
information they recognize. Based on the analyzed 
information and the instructions they receive, they 
make decisions and act independently.

Basic Components of a Robotic System
Robots use various types of sensors to perceive 
their surroundings. These sensors (input devices) 
gather information, which is then processed 
by microcontrollers or microprocessors. The 
choice of processor depends on the volume 
and complexity of the data to be processed. As 
the data requirements grow, the efficiency and 
number of processors are scaled accordingly. 
Based on the processed information, the robot's 
control unit manages the output devices.
Output devices in robots include LEDs, buzzers, 
display units, motors, and complex mechanical 
components, depending on the specific 
application. The components responsible for 
enabling automatic movement in robots are 
known as actuators. Examples of actuators 
include servo motors and stepper motors.

Have you understood the basic components 
required for the functioning of robots?

Now complete the table 6.1 on the components 
of robots and their uses. Some of the components 
mentioned in this are available in the robotics kit in 
your computer lab. Check them out to complete the list.



The World of Robots

Information & Communications Technology-10 100

Table 6.1  Components of Robots and their Uses

Category Component Use

Input Unit

Light Sensor To detect the presence of light.

IR Sensor	
To detect the presence of objects with the help of 
infrared rays.

Microphone

Camera To collect information in the form of images.

Control Unit

Arduino	

The information received through input devices is 
processed, decisions are made based on the given 
instructions and actions are carried out throught the 
output devices.

Raspberry Pi

ESP32

Output Unit

LED To display the output in the form of light.

Buzzer

Servo Motor Used to perform automatic/mechanical movement.

Robotics
Robotics is the science that studies the design, construction, operation and control of robots 
using appropriate software. It combines electronics, mechanical engineering, and computer 
science. Knowledge in these diverse fields is essential for building robots. The rapid 
advancement of artificial intelligence technology is also driving significant progress in the 
field of robotics today.

Usually, programmable microcontroller chips 
act as the brains of robots. The Arduino UNO board in 
the robotics kit given to schools has a microcontroller 
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called ATmega328P embedded in it. Using Arduino 
and its related components, we can create prototypes 
or miniature versions of electronic devices commonly 
seen around us. Let’s explore how to make such devices 
using the components in the robotics kit.

Let's Get to Know Arduino
Arduino is a world famous open-source hardware/

software platform. Arduino was created in 2005 by a 
research team at the Interaction Design Institute Ivrea 
in Italy, with the aim of making physical computing 
devices that connect sensors, actuators and other 
components easier, cheaper, and more popular to build.

Arduino models are available to suit different 
needs. The Arduino Uno R3 model is shown in Fig 6.1. 

Microcontroller

A microcontroller is a small computer integrated into 
a single chip. It contains the main components of a 
computer system, including the processor, RAM, ROM, 
and input/output interfaces, all within the microcontroller 
chip.

1.	 Microcontroller Chip  
(ATmega328P)

2.	 DIGITAL I/O PINs (0 to 13)	

3. USB Port	

4.	 External Power Supply	

5. 3.3V DC PIN

6.	 5V DC PIN	

7. GND			 

8. Analog Input

Fig 6.1  Arduino Uno R3 - Major Components
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Look at Table 6.2 and find the major components 
of Arduino and their uses.

Component Use

Microcontroller 
Chip 

(ATnega328P)

This part is called the brain of Arduino. It collects information and controls 
the devices according to the instructions.

DIGITAL  
I/O PINs

Collects data from input devices. Controls output devices. The pins  
marked with tilde (~) symbol can also be used for Pulse Width Modulation 
(PWM).

USB Port For connecting to computer to upload programs and transfer data.

External Power 
Supply For supplying power to the board from the battery or other external source.

5V PIN This provides a steady 5V.

 3.3V PIN This provides a steady 3.3V.

GND This provides the ground potential (0V) of the Arduino.

Analog Input For measuring analog voltage.

Table 6.2  Arduino Uno R3 - Major Components and their Uses

Breadboard
A breadboard is a device that allows you to build and reuse circuits by connecting electronic 
components to each other without soldering. The terminals of electronic components can be 
attached to the holes in the breadboard. These holes are internally connected to each other 
using conductive wires, as shown in the second picture.

Fig 6.2  Breadboard

Let’s Light LED Lamps
Haven't you prepared circuits for lighting a 

filament bulb used in a torch battery (Fig 6.3) in 
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science classes? Now, what about preparing a circuit 
for lighting an LED?

See the circuit diagram given in Figure 6.4. Here, 
instead of a battery, Arduino is used to provide power.

Let's take a look at the things to note when 
designing a circuit like this.

	� The positive terminal of the power supply should be 
connected to the anode of the LED and the negative 
terminal should be connected to the cathode of the 
LED.

	� A suitable resistor should be connected in series in 
the circuit.

Open the robotic kit and make a circuit as shown 
in Fig 6.4 using the Arduino, LED, resistor and jumper 
wires. Then, connect the Arduino to the computer. The 
USB cable in the kit can be used for this.

Doesn't the LED light up? Repeat the experiment 
using LEDs of different colours.

Blinking LED 
You now understand how to power an LED using 

an Arduino.

Fig 6.3  Circuit of Filament Bulb

G
N

D

5V

Fig 6.4  LED bulb Circuit Using Arduino

LED (Light Emitting Diode)
An LED is a two-terminal electronic device 
belonging to the diode category that conducts 
electricity in only one direction and emits energy 
in the form of light. Electricity will flow through 
the LED circuit only if its anode terminal is 
connected to the +ve of the battery and cathode 
to the -ve of the battery. Typically, the anode 

terminal of the LED is slightly longer than the cathode. To prevent excessive current flow 
and potential damage to the LED, a resistor must be connected in series with the LED circuit. 
The resistor's value depends on the maximum power the LED can handle and the voltage of 
the power source.

Cathode (-)
Anode (+)
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Now, let's learn how to make an LED blink 
using Arduino. What changes need to be made in the 
circuit for this?

We are using 5V power from the Arduino to 
operate the LED. But is it enough to simply connect 
the 5V pin to make the LED blink? No, the 5V pin 
provides a constant 5 volts, so it cannot be used to 
make the LED blink.

To create a blinking LED, we need to connect 
it to one of the digital pins (PIN 0 to 13), which can 
control the power (turning it ON/OFF). We then give 
the necessary instructions to the Arduino to control 
this power.

Observe the circuit diagram shown in Fig 6.5 
and build the circuit based on this model.

GND

DIGITAL PIN 13

Fig 6.5  LED Circuit Connected in PIN 13 of Arduino
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In the circuit, the anode of the LED is connected 
to DIGITAL PIN 13 through a resistor. When this pin 
is ON, the LED will light up, and when it is OFF, the 
LED will go out.

The Arduino circuit is now complete. Next, we 
need to give the Arduino a command to turn PIN 13 
ON/OFF.

To do this, you need to write a program on the 
computer. This can be done using PictoBlox, which we 
learned in previous classes. Before writing the program, 
we need to set up the connection between the Arduino 
and the computer.

Connect the Arduino board to the computer as 
shown below.

To Connect Arduino to Computer
	� Connect Arduino to computer using USB cable.

	� Open PictoBlox on computer and select Block Coding.

	� Then, select Ardunio UNO board from Board menu.

	� Open the Connect menu and click the Connect button against the Arduino connected via 
USB to establish the connection.

	� After that, change the programming mode to Upload Mode.
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Programming Modes in PictoBlox
There are two ways to program Arduino using PictoBlox.

1. Upload Mode:

In this mode, the program prepared on the 
computer is completely uploaded to the memory 
of the Arduino microcontroller. Later, it does 
not require a computer to run the program.  
The Arduino only needs to be powered on.

The given code block will only work in upload mode.

2. Stage Mode:

In this mode, the Arduino must first be configured using the Upload Firmware method to 
run the Arduino. Once the firmware is uploaded, the Arduino will operate according to the 
instructions received via the USB cable. In this mode the program can be run only when the 
Arduino is connected to the computer. 

 This code block will only work in stage mode.

Have you connected the Arduino board to the 
computer? Now, check the Blocks tab in pictoblox. 
Here you will see some new code blocks related to the 
Arduino Uno. 

From this, you can find out which instruction 
should be used to turn DIGITAL PIN 13 ON.

If so which instruction should be used to turn 
DIGITAL PIN 13 OFF?

	� Just make the output of DIGITAL PIN 13 LOW.

Now prepare the program given in Figure 6.6 
and upload the program to the Arduino using the  

  button. 
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Language of Computers

In the previous 
chapter, we have 
learned about 
binary language, 
the only language 
that computers 

can understand. We have already 
discussed that instead of 0 and 1 in 
the binary number system, we use 
LOW, HIGH, FALSE, TRUE, 
OFF, ON respectively. These are 
called "bits". Each bit represents a 
switch, which can be on (1) or off 
(0). These bits are added together 
to represent all the information we 
use on computers every day, such 
as text, images, and videos.

Fig 6.6  LED Blinking Program

Is the LED  in the circuit blinking?

What changes should be made in the code to 
increase the speed of blinking of the LED?  Try to do it.

Beep... Beep…
We made a system, blinking LED using a 

computer program. Is it possible to make a device that 
produces a beep sound at intervals in the same model?

Observe the circuit diagram in Fig 6.7. Here, a 
buzzer is connected in the circuit instead of an LED.

5V

DIGITAL PIN 8

VCC
I/O

G
N

D

Fig 6.7  Circuit in which Buzzer is Connected
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Buzzer Module

This is an electronic component used to produce a beep sound. 
It can be powered by connecting the VCC of the buzzer to the 
5V of the Arduino and the GND of the buzzer to the GND of the 
Arduino. It produces sound when a LOW signal is given to the  

I/O PIN. The sound stops when a HIGH signal is received on the I/O PIN.

Observe the figure and identify the digital pin 
in Arduino board with which the middle pin of buzzer 
(I/O PIN) is connected.

If we want the buzzer to produce a 'beep' sound at 
regular intervals, what changes should we make in the 
program we prepared earlier? Try it.

Automatic Sanitizer Dispenser
We have discussed that robots collect information 

from their surroundings through various sensors and 
act accordingly. Let's try to build a sensor-based device.

Do you remember how we  used sanitizer to clean 
our hands during the COVID-19 pandemic to prevent 
the spread of disease?

Imagine a sanitizer bottle that dispenses sanitizer 
as soon as our hand comes near it, without having to 
touch the bottle.

How do these devices detect the presence of our 
hand?

	� IR sensors

	� Ultrasonic sensors

	� LiDAR (Light Detection and Ranging)

This can be achieved by using the above given 
sensors.

Mini pumps or electronic taps are commonly 
used to control the release of sanitizer. There should 
also be a controller chip to connect the sensor and the 
tap to each other.
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Let's make a device that detects the presence 
of  hand and dispenses sanitizer. It should be made 
according to the model given in Fig 6.8.

What components are needed for this? Let's check 
the availability of these components  in our robotic kit.

	� IR sensor module to recognize the presence of hand.

	� Servo motor to control the tap of the sanitizer bottle.

	� Arduino to control these logically.

Observe the circuit in Fig 6.9. What settings are 
made in it?

Fig 6.8   
Automatic sanitizer dispenser  Design

GND

5V

DIGITAL PIN 8DIGITAL PIN 9(~ PWM)

G
N

D
5V O

U
T

Fig 6.9  Automatic Sanitizer Dispenser  Circuit

	� Power is given to the servo motor and IR sensor from 
Arduino.

	� The output pin of the IR sensor module is connected 
to DIGITAL PIN 8 of Arduino.

	� The control pin of the servo motor is connected to 
DIGITAL PIN 9 of the Arduino. (DIGITAL PIN 9 is 
also a PWM pin. PWM pins are used to control the 
servo motor).

Set up this device as shown in the diagram in  
Fig 6.8 using Arduino, servo motor, IR sensor module 
and sanitizer bottle.
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Servo Motor
Servo motors are not designed to rotate 
continuously like other motors. A servo motor 
with three connection wires has a control wire 
in addition to the power wires. The servo 
motor shaft rotates through angles from 0 
to 180 in accordance with the signal voltage 
supplied to this control wire. Servo motors 
are usually controlled by Arduino using PWM 
(Pulse Width Modulation).

The red wire of the servo motor shown in 
the picture can be connected to the 5V of the 
Arduino and the brown wire to the GND of 
the Arduino to provide power. The signal received on the orange wire determines the angle to 
which the output shaft of the motor should rotate.

Now, let's prepare a program to make this system 
work.

	� When an object comes in front of the IR sensor, the 
output pin will be in the OFF (0) state. To detect this, 
we can use the code   
in PictoBlox. In this state, the tap of the sanitizer 
bottle should be opened.

	� The device should be set up in such a way that when 
the shaft of the servo motor reaches 90 degrees, the tap 
of the sanitizer bottle should be opened. Then, to open 
the tap, just give the code . 

	� After that, the device should also be adjusted in such 
a way that the tap closes when the servo motor shaft 
reaches 0 degrees. The device configured in this way 
opens the tap when the hand comes near and closes 
the tap when the hand is removed. The code prepared 
in PictoBlox for this is shown in Fig 6.10.
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IR Sensor Module

This is an electronic component 
that is used to detect obstacles 
in front with the help of infrared 
waves. If an object comes in front 
of the IR sensor module, the OUT 
PIN will become LOW (OFF) and 
when the object moves, the OUT 
PIN will become HIGH (ON).

Fig 6.10  Automatic Sanitizer Dispenser  - Program

Make necessary changes in this code as per the 
design you made for your Sanitizer Dispenser and 
upload it to the Arduino and run it.

The automatic sanitizer dispenser works by 
recognizing the presence of our hand.

Have you seen other devices that work by 
recognizing our presence in this way?

	� Automatic tap

	� Automatic door

	� …….................................................………………..

Discuss whether it is possible to prepare a model 
of these devices using the components in the robotic kit.

Artificial Intelligence and Robotics

We have learned in previous classes that artificial 
intelligence is a technology that enables machines 
to learn and solve problems by imitating human 
intelligence and thinking skills. Artificial intelligence 
and robotics can do many amazing things when they 
come together. Just imagine what they could be.
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	� Robots that perform surgeries in the healthcare 
sector.

	� Robots that manufacture products in factories.

	� Robots that engage in space travel.

	� Robots that engage in agricultural work.

	� Robots that prevent environmental pollution.

	� ……........................………………………………...

In short, robots are growing to be able to perform 
tasks with precision and efficiency beyond human 
intelligence.

Aren't you interested in creating devices that 
work with artificial intelligence? How about we make 
one of them?

A Door that Opens by Recognizing Faces
We have discussed the functioning of a door that 

opens automatically by recognizing human presence. 
A passive infrared sensor (PIR sensor) is usually used 
in such a system. This sensor detects the infrared 
heat radiation emitted by the body of living beings. 
Therefore, the door will open even if animals come.

How can we make a door that opens only when 
there is a human presence? Why not use the computer 
vision technology that we learned in previous classes 
for this?

Shall we  make a smart door system that opens 
only when a human face is seen in front of the camera?

Since Arduino does not have a camera, we can use 
our laptop's camera to prepare this system. Therefore, 
we need to prepare the program in Stage Mode in 
Pictoblox.

Human faces can be detected using the extension 
named Face Detection in Pictoblox.
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Set Stage Mode in Pictoblox as shown on the left 
and include the Face Detection extension.

Did you add the Face Detection extension to your 
system?

Now, let's prepare a miniature of the door that 
works by recognizing faces. Examine the diagram in 
Fig 6.11. Prepare the circuit and create a miniature of 
the smart door system. 

‌To Include Face Detection 
in Stage Mode

	� In Stage Mode, connect the 
Arduino to the laptop and configure 
the Arduino using the Upload 
Firmware option.

	� Then  include the facility in the 
following way:,

  Add Extension → 

 Face    Detection

Now let's program it.

How can we detect if a human face is caught on 
camera?

	� In Pictoblox, we can turn on the camera using the 
code   .

	� You can analyze the images captured by the camera 

using   and find the number 

of faces identified using the  code.

Examine the code given in Fig 6.12. The shaft 
of the servo motor is rotated to 90 degrees to open the 
door and to 0 degrees to close it.

	

Fig 6.11 Smart Door System - Circuit

DIGITAL PIN 3 (~PWM)

G
N

D

5V
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Make necessary changes in this code according 
to the configuration of the servo motor attached to the 
smart door system you have prepared and try it out.

Fig 6.12  Smart Door System - Program

	� Which of the following can be used as an actuator in a robot?

			  a) IR sensor			   b) Servo motor
			  c) LED				   d) Arduino

Let's Assess



115

The World of Robots

Information & Communications Technology-10

Extended Activities

1.	 Did you use Arduino to light up an LED? Make a model of a traffic signal using green, red, 
and yellow LEDs.

2.	 Modify the smart door system you created so that it recognizes only you and functions 
accordingly.

3.	 Using the light sensor from the robotic kit, create a model of an LED light system that 
automatically turns on at night.	

	� Analyze the code given in the figure and find the correct statements given below.

	       	

			  a) An output device is connected to Digital PIN 4.
			  b) An output device is connected to Digital PIN 10.
			  c) An input device is connected to Digital PIN 4.
			  d) An input device is connected to Digital PIN 10


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CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national 
struggle for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon 
to do so;

(e) 	to promote harmony and the spirit of common brotherhood amongst 
all the people of India transcending religious, linguistic and regional 
or sectional diversities; to renounce practices derogatory to the 
dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, 
lakes, rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry 
and reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and 
collective activity so that the nation constantly rises to higher levels 
of endeavour and achievements;

(k) 	who is a parent or guardian to provide opportunities for education 
to his child or,  as the case may be, ward between age of six and 
fourteen years.



CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in
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